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VFO is a gateway between service/network providers.   The application is 
accessible via a web-based Graphical User Interface (GUI), in addition to the 
following features/functionality:   

• Flexible and automatic validation of Access Service Requests, Local 
Service Requests and Trouble Reports. 

• Storage and management of all service requests submitted, and the 
subsequent notifications received. 

• Secure and efficient business interactions between the companies.     

To understand VFO, it is helpful to understand how it works  with the 
Exchange Path application.  

Exchange Path enables real-time data transfer with other trading 
partners.  Exchange Path uses the following Transaction and Message 
Formats: 

• Local - EDI, XML 

• Access – UOM/XML 

• Trouble Administration – XML 

Exchange Path uses the following Transmission Protocols: 

• Interactive Agent 

• HTTP 

 

The process begins with the end user populating the VFO GUI, followed by 
the below list of activities:    

1. VFO creates an XML based on the values entered in the VFO GUI. 

2. The XML is sent to Exchange Path where the XML is compared 
against the Trading Partner's Business Rules. 

3. If no rules are violated, the XML is translated into the Trading 
Partner's preferred format. 

4. Exchange Path transfers the message to the Trading Partner.  

5. The Trading Partner checks the message against their system. 

6. The Trading Partner transmits the response-message to Exchange 
Path. 

7. Exchange Path translates the message back into XML and then 
sends that XML back to VFO and updates the order's status.  
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High quality, cost-effective interactions between telecommunications 
providers can be attained through a high degree of mechanization. However, 
direct interfaces between the OSS of various providers are costly and create 
opportunities for insecure handling of critical business information.  

VFO provides a secure gateway for handling these interactions and helps to 
realize the following benefits: 

• Achieve cost-effectiveness by handling requests as part of a 
mainstream operations flow (i.e., automated flow through) instead of a 
manual effort. 

• Facilitates interactions between associated communications 
customers and providers via integration into existing/evolving 
operations systems architectures. 

• Improves time to service by minimizing manual efforts and the errors 
associated with manual processing. 

• Maintains a historical record of Orders processed. 

• Meets the transmission protocol requirements. 

• Performs Order functions over a user-friendly, completely web-based 
interface. 

• Provides the ability to validate transaction data before submission to 
the Trading Partners; thus reducing costs to manage fall -out. 

VFO General Information 

Audience 

The primary users of this guide will be the provisioning specialists or users 
whose responsibilities include provisioning resources from outside 
sources.  It is assumed that the users of this manual are knowledgeable 
about the telecommunications industry as well as efficient provisioning 
practices. 

Conventions 

This manual is organized as follows. 

• Buttons and links that you click will be bold.  

• Windows will be displayed as screen shots. 

• Paths are represented by the ‘>’ key.  For example, Start > Programs 
> Microsoft Word.  This path represents the steps followed to use 
certain functions within the application. 

The examples used in this guide are fictitious.  Any similarity to actual data 
is merely coincidental.  The sample data does not represent proprietary data 
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from any other company.  Furthermore, the screen shots used in this 
document are not specific to any industry version.  

Purpose 

This manual is intended to provide methods of processing and maintaining 
orders.  Specifically, this manual explains how to: 

• Create and manage Service Requests 

• Create and manage Service Order templates 

• Perform tasks in the Service Ordering process 

• The VFO User Guide is designed to act as a tool to provide a 
systematic process for conducting daily tasks. 
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This guide is intended to provide methods of processing and maintaining 
orders.  Specifically, this electronic guide explains how to: 

Get Started in VFO - In this section you will learn how to log on to the 
application, change your password, work with the home page transaction list 
and use the action icons to initiate commands. 

Access PreOrder Search and Response - This section covers creating 
Location, Ethernet, and CFA Inquiries, printing and saving responses, and 
searching for saved responses. 

Create and Manage Outgoing Access Orders - In this section you will learn 
all the functions available for Access Order requests, from creating, 
validating, and submitting orders to searching, supplementing, viewing order 
histories, and creating manual responses. 

Work with Access Order Templates - This section reviews how to create, 
search, and apply templates to access orders. 

Create and Manage Incoming Access Orders - In this section, you will learn 
how to respond to order requests.  It covers starting a response transaction, 
saving, validating, submitting, and searching for the response.  

Local PreOrder Search and Response - This section reviews the general 
process for creating, submitting, printing, and search for PreOrder 
transactions. 

Create and Manage Outgoing Local Orders - In this section, you will learn 
how to create local service requests, validate the order against  the trading 
partner's business rules, submit orders and supplemented orders, view the 
order responses, and history, just name a few.  

Work with Local Order Templates - This section reviews how to create, 
search, and apply templates to local orders. 

Create and Manage Incoming Local Orders - In this section, you will learn 
how to respond to order requests.  It covers starting a response transaction, 
saving, validating, submitting, and searching for the response.  

Trouble Administration - In this section, you will learn how to create a trouble 
ticket request, query the progress, and search for previous trouble tickets 
submitted.  This section also reviews how to submit Mechanized Loop Tests 
(MLT) and late bond verbal tickets to automated requests.  

To learn more about the Virtual Front Office application, go to the 
Introduction to Virtual Front Office section of the Guide. 
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VFO is a web-based application that runs on Google Chrome and Microsoft 
Edge; therefore, the user must open a supported Web browser to access the 
application.  

(If necessary, consult the browser’s User’s Manual for the browser’s setup 
and operating procedures.)   

When the browser opens, enter the following in the Address line:  

                  https://vfo.frontier.com/  

 

 Login Procedure 

Use the following procedure to log into VFO. 

1. Browse to the VFO location by entering the following address in the 
Address field: 
https://vfo.frontier.com/  

 

Figure 1: Login page 

 

2. Enter a valid name in the User Name field.  

3. Enter a valid password in the Password field.  

4. Click the drop-down arrow in the Module field. 

5. Select the desired Module. 

6. Click the Login button. 

NOTE: Use the User Name and Password provided by the company’s 
System Administrator.  You will be forced to reset any password created by 
the System Administrator. 

  

https://vfo.frontier.com/
https://vfo.frontier.com/
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Change Password 

Use the following procedure to change the VFO Login password.  

1. Browse to the location of VFO. 

2. Enter a valid name in the User Name field.  

3. Enter a valid password in the Password field.  

4. Use the User Name and Password provided by company’s System 
Administrator. 

5. Click the dropdown arrow in the Module field. 

6. Select the desired Module. 

7. Check the Change Password checkbox. 

8. Click the Login button. 

  

Figure 2: Change password page 

9. Enter the old password into the Old Password field.  

10. Enter the new password into the New Password field.  

11. Reenter the new password into the Confirm New Password field. The 
‘Password Rules’ link mentions the criteria for choosing a new password.  

12. Click the Update Password button. 

13. Log in using the new password. 
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Password Rules 

The password rules are intended to maintain the system security by 
prompting users to provide strong passwords and use them appropriately. 

   

Figure 3: Password Rules 

 

First Time Logging In – Security Questions 

The first time you log into VFO, you will be asked to reset your password, 
answer three security questions of your choice, and provide or confirm your 
email address.  You will then be set a verification code to enter.  

 

1. Select the security questions you would like to answer. 

 

 

Figure 4: Security Question 

http://en.wikipedia.org/wiki/Password
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2. Enter your answers to each before clicking Next. 

 

Figure 5: Security Questions and Answers 

 

 

3. Enter your email address (Email ID) or verify the one already 
associated with your user profile. 

 

Figure 6: Security email address 
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4. The email address format will be validated, and a verification 
code will be sent to the email address provided. 

  

Figure 7: Security Questions and Answers 

 

5. Enter that verification code to proceed. 

 

Figure 8: Security Questions and Answers 

 

The email address can now be used to retrieve the forgotten user name.  
And if you forget your password, the email address and security questions 
and answers can be used to authenticate your login. 
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User Profile  

A user profile icon  is on the home page to enable you to manage your 
email and security questions.  All other fields are read only. 

 

Figure 9: User Profile Icon on Home Page 

 

 

 

Figure 10: User Profile Details 
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Retrieving Forgotten User Name 

If you forget your User Name, you can retrieve it from the system, by clicking 
Forgot User Name?.  You will enter your email address associated with the 
User Name and the system will generate an email with the associated User 
Name(s) with that email address  

  

Figure 11: Forgotten User Name Email ID  

 

Upon inputting a valid email address, all usernames associated with that 
email address will be listed in the email sent.  

  

Figure 12: Forgotten User Name Email Message 
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Resetting Forgotten Passwords 

If you forget your password, you can reset it using the security questions 
answered the first time you logged in. 

Click the Forgot Password” link on the VFO Login Page to trigger a four-
step user authentication process. 

• You will be prompted to enter your username. 

  

Figure 13: Forgotten Password User Name. 

• You will need to answer a security question associated with your 
user profile. 

 

Figure 14: Forgotten Password Security Question 

VFO will send a verfication code, which you will use to access 
VFO, if the answer to the question above is correct.  

 

Figure 15: Forgotten Password Verification Code 

 

NOTE: Check your junk email, if you don’t see a verification code within 5 
minutes.  If still no code, wait an additional 10 minutes before clicking 
Regenerate to get a new code sent. 
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• After entering the correct verification code, and clicking Next, 
you will enter your new password twice. 

 

Figure 16: Forgotten Password New Password Entry 
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Module Lists 

In each module, the first screen to appear is the list of existing orders that 
are stored in the application.  The list name is referred to differently in some 
of the modules, as referenced below: 

Module  List Name 

Access Order List 

Local Order List 

TA (Trouble Administrator) Work List 

NOTE: A company’s internal process for managing orders will dictate what 
orders will be viewable to a user. Viewing capabilities are managed via the 
Filter function, which will be covered further down in the document.      

 

 

Figure 17: Access service request order list 

<Module> - Use this drop-down menu to change modules without logging 
out of VFO.  Select the module from the dropdown menu, and then click the 
Launch button next to the <Module> to open the home page of the selected 
module. 

Home – Click this link to return to the Order List page. 

About – Click this link to open a popup window that lists:  

• The login name of the current user 

• The current user’s full name 

• the date and time the current version of the application was installed 

• Any TP Package details for installed TP Packages  

• VFO copyright information  

Help – Click this link to access VFO Online Help. 

Logout – Click this link to logout of VFO and return to the Login page. 
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Order – Hover over this tab to access functionality to create or search for an 
order. 

PreOrder – This tab allows you to initiate, search and/or submit pre-order 
transactions. 

Template – Hover over this tab to access functionality to create or search 
for a template. 

Administration – Hover over this tab to access User Profiles and other 
security related information.  This tab will only be visible if you have 
sufficient permissions. 

Another feature of the List is the shading of certain orders.  

• When an order has been reassigned it will be shaded gray. 

• If the order is considered a Protected Circuit, the PON will be 
highlighted in yellow. (Access Module only) 

• If an order was initiated by a user that is no longer active, the user 
name will be shaded pink. 

NOTE: The default colors can be changed to suit the needs of the 
company.  Check with the System Administrator if different colors are 
observed. 

Sorting the List 

A module list can be sorted in ascending or descending alpha or numeric 
order based on the specific column header selected.   In the TA module, 
there is a downward facing arrow in one of the column headers when the 
module is opened to the home page.  Clicking the column name of any other 
column will move the arrow and re-sort the list according to the selected 
header. 

For example, if you wish to sort the entries by State, you would click the 
State column.  The arrow would then appear to the right of that column’s 
name and the orders would be sorted alphabetically according to the State. 
Clicking the header a second time will reverse the sorting order.  

Please note that while clicking on the headers in the Access and Local 
modules will sort the orders.  However, the default sort is not based on any 
column heading, so no arrow appears for the default sort.  The default is to 
sort the records based on the latest time stamp on the transaction.  So after 
an order is created, modified, or it receives a response, etc., it appears at 
the top of the list until another transaction is placed or moved to the top 
based on a recent transaction.    

If you change the sorting in the Access and Local modules and want to 
return to the default sort, click the Return to Default Sort icon.  
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Sorting the History List  

The user clicks on the History icon to view the PON’s history. User can then 
sort these entries either in ascending or descending date/time order by 
clicking on the Date/Time column.  The resulting display will be transactions 
sorted by date/time,, regardless of their versions. 

For example, if you wish to sort the entries by Date/Time,  you will click the 
Date/Time column. The arrow would then appear to be pointing upwards and 
the entries would be sorted in ascending order. Clicking the Date/Time 
column again will sort the entries in descending order with the arrow pointing 
downwards.   

If you want to return to default sort, click the Return to Default Sort icon. 
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Using VFO’s Action Icons 

The following icons are used throughout VFO, in most modules.   In 
situations where they are not seen, it is because they are context 
specific and not always a viable function. 

NOTE: To specify a record, you must first click the checkbox or radio button 
to the left of the record. 

User Profile – Manage User Information History 

This function will allow a user to see the email associated with 
his/her user name, change the security question and/or change 
the security questions. 

 

Open Book – History Function 

This function will allow a user to see any previous actions that 
have been performed on a particular order. 

 

 

Sheet of Paper – Create Response Function 

This is used primarily in the Service Request Receive functions 
but is also available for manual creation of responses sent.  

This icon is not used in the TA module.  

 

Funnel – Filter Function 

The Filter function allows the user to specify which records 
appear in a specific module list.  The most recent filter is 
automatically stored in the system so that the next time the user 
logs in the list will display the latest filter selection.   Different 
filter options are applicable for each module.   

NOTE: Different Filter options are applicable for each module and will be 
discussed the in the appropriate sections below.   

 

Gray Box in Front of Computer – Return to Default Sort Function 

This resets the view to the Default sort, which arranges items in 
the list based on date and time of last update.   

This icon is not used in the TA module.  
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Excel Symbol – Export to Spreadsheet Application 

This function will export the Order List data to Excel.  It uses 
Comma Separated Values (CSV) format; so other spreadsheet 
applications can be used.  The icons provided in the Order List 
are not exported and instead columns are provided with a True 
Value to indicate if the order is an Access Multi-EC order or if it 
was created as a Tracking Only Order. 

Two Green Arrows – Refresh Function 

This function will refresh the window in which the icon is 
displayed.  It applies to a pop-up window that is displaying the 
details of an order that was just placed, or to the module list to 
check the current status of all orders. 

Box above Note – Back to Order Function 

This will take the user back to the previous 
screen.   Specifically, it will allow the user to return to an Order 
after viewing the History. 

Printer – Print Function 

Clicking on this icon will print the current screen through the 
default printer that is configured with the browser. This function 
is valuable to provisioners who require hard copies of orders.  

This icon is not used in the TA module. 

Disks – Save Function 

This function allows the user to save any changes to a currently 
displayed order.  This function, when used with the History 
function, allows the user to save previous versions of an order 
as the current version. 

This icon is not used in the TA module.  

Running Man – Submit Function 

This function first validates the order based on the rules built 
into the GUI. (e.g.: required fields, correct date and number 
formats, etc.). Once this GUI validation is completed, the order 
is sent to Exchange Path for Business Rule Validation.  If the 
order passes the Business Rule validation, it is then sent to the 
Trading Partner. 

Green Check Mark – Validate Function 

This performs the GUI validation and Business Rule validation 
on the order displayed. This is automatically performed when 
Submitting the order, but this gives the user the option of 
performing the validation process without submitting the order.  

This icon is not used in the TA module.   
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This section explains the procedures for performing the following tasks: 

• New Access PreOrder Inquiry Procedure 

• Save Access PreOrder Response 

• Print Access PreOrder Response 

• Search Access PreOrder Responses 

• Print Access PreOrder Search Results 

New Access PreOrder Inquiry Procedure 

Use the following procedure to perform a new PreOrder Inquiry.  

1.    Login to VFO and select the Access module.   The Order List page 
opens. 

2.   Execute the PreOrder>New menu command.  The PreOrder Initiation 
window opens. 

WARNING: An error message will be displayed if configuration to this function is not 
accessible.  

 

Figure 18: PreOrder initiation page 

3.   The Message ID will be automatically populated with an incremented 
entry. The Message ID value that was auto-populated can be manually 
changed.   

4.   Select a Receiver Code. 

5.    Select the Service Type from the dropdown menu. 

6.   Click Initiate. This opens the PreOrder Request window. 
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7.    Selecting the CFA Inquiry in the Initiation window will generate the 
following PreOrder Request window to appear.  

 

Figure 19: CFA inquiry page 

8.   Selecting the Location Inquiry in the Initiation window will generate the 
following PreOrder Request window to appear. 

 

Figure 20: Location inquiry page 

NOTE:  The Location Inquiry Switched Ethernet Only option is also available.  
Information for this inquiry is not provided in this user guide.  Please refer to:  ASR 
Pre-Order Location Inquiry Switched Ethernet Only Job Aid 

https://wholesale.frontier.com/-/media/WholesaleDocs/asr-pre-order-location-inquiry-switched-ethernet-only-job-aid.ashx
https://wholesale.frontier.com/-/media/WholesaleDocs/asr-pre-order-location-inquiry-switched-ethernet-only-job-aid.ashx
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9. Populate the fields with the relevant search criteria.   Yellow 
highlighted fields require data to be input in order to proceed to the 
next step.  

10. Click Submit.  The results are then displayed in the PreOrder 
Response window. 

 

Figure 21: CFA query results 

 

For large responses, to view the entire response you may need to use 
the pagination provided for each section containing more than 10 
items. 

 

Figure 22: PreOrder pagination of results 

Enter the number of records you want displayed at any one time for 
that section and click the SHOW link.  The default is to show up to 10 
items at a time before needing to move to the next page.  

Click the outside arrows to move to the first or last page.  

Click the inside arrows to move page by page. 

• To modify the PreOrder Request, click the Inquiry tab.   This re-
opens the PreOrder Request. 

• Click the Change button to edit the fields.  

• Make the desired changes and click Submit to resubmit the 
PreOrder Inquiry. 

NOTE: This window can remain open while starting another Order. This 
allows a user to cut values that are in the Response window and paste 
them into the respective fields in the Order window.  The query can 
also be performed from within the Order itself. 
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Save Access PreOrder Response 

Use the following procedure to save PreOrder Inquiry and Response 
transactions. 

1.    Execute a PreOrder Inquiry.  Be sure to be in the PreOrder 
Response window. 

2.   Scroll to the bottom of the window and click Save. 

Print Access PreOrder Response 

Use the following procedure to print PreOrder response details 
immediately after generating the response. 

1.    Execute a PreOrder Inquiry.  Be sure to be in the PreOrder 
Response window.  

2.   Click Printable Version to open a new window with a version of 
the Response that is better formatted for a printer.  

3.   Click Print.  The Print dialog box opens to allow printing based 
on the user’s print configuration.  

Search Access PreOrder Responses 

Use the following procedure to view PreOrder Response details.  

1.    Login to VFO and select the Access module.  The Access Order 
List page opens. 

2.   Hover your cursor over the PreOrder tab.  A dropdown menu 
opens. 

3.   Execute the PreOrder > Search menu command.   The PreOrder 
Search page opens. 

 

Figure 23: PreOrder search page and results 
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3. Users can search using the following criteria. 

      TX Num—Enter the number of the Transaction to search. 
This field supports wildcard searches using the % symbol.  

      ICSC—Click the dropdown menu to select the ICSC on 
which to search.  This populates the TX Type menu with the 
transactions that are available for the selected Interexchange 
Customer Service Center (ICSC). 

      Service Type—Click this dropdown menu to select a type of 
service (i.e.  Address Validation, CFA_Inquiry, 
Location_Inquiry).    

      Public Search—Check the checkbox to search for all 
PreOrders.  This enables a search that is no longer limited to 
a specific user ID.    

      TX From Date (MM/DD/YYYY)—The first day of the date-
range the inquiry was sent from VFO. 

      TX To Date (MM/DD/YYYY)—The last day of the date-range 
the inquiry was sent from VFO.  If left blank, the system 
searches up to the current date. 

      Response Type—Click this dropdown menu to select the 
type of response (i.e. Alternatives Exists, Found, Not Found, 
Restricted). 

      Go—Click this button to submit the search criteria and view 
the returns. 

      Clear—Click this button to empty all the populated fields.  

5.    Enter the appropriate search criteria. 

6.   Click Go to perform the search.  The results will display in the 
bottom half of the window. 

Print Access PreOrder Search Results 

Use the following procedure to print the PreOrder Search results.  

1.    Execute a PreOrder Search.  

2.   Click the Message ID link of the PreOrder to be printed.  

3.   Click Print.  The Print dialog box opens to allow printing based 
on the user’s print configuration. 
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This section reviews the following: 

• Using the Access Order List 

• Work Status Icons 

• Access Order Statuses 

• Creating  Access Orders 

• Validating  Access Orders 

• Access Four-Step Ordering Process 

• Tracking Access Orders 

• Searching Access Orders 

• Filtering Access Order List 

• Creating Access Response 

• Supplementing Access Orders 

• Using the Save As function 

• Updating Access Request General Information 

• Viewing Last Notifications 

• Using the History Function 

• Reverting to Last Saved version of the order 

• Reverting to Last Submitted 

• Viewing Error List 

• Resending Access Orders 

• Using External Applications 

Using the Access Order List 

The Order List pages display all of the orders entered into VFO.   Each 
row represents a particular order and shows the following information:  

• Receiver Code 

• Customer Code 

• Purchase Order Number (PON) 

• Version of the Order (Ver) 

• Supplement Type (Sup) 

• Current Status (Status) 

• Transmission Type (Trantype) 
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• Service Type (Svctyp) 

• Request Type (Reqtyp) 

• Activity (Act) 

• Desired Due Date (DDD) 

• Owner 

• Date Sent/Received 

 

Figure 24:  Order list 

 

Work Status Icons 

There may be an icon in front of some of the tickets to indicate 
different work states.  Following are what these icons represent: 

Clock 

The order is in a “Pending” state.  A pending state exists when an 
order has not been updated by the Trading Partner within the Service 
Level Agreement (SLA) timeframe.  The work state will change as 
soon as the Trading Partner updates the status of the order. This icon 
also appears when the order is pending a Firm Order Confirmation, 
Design Layout Report or Completion Notification from the Trading 
Partner. 

 

Flame 

The order has been rejected by the Trading Partner.   This is not due to 
Business Rule violations, as those would result in a different work 
status icon. 
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Green Check Mark 

The order has been completed by the Trading Partner.  

 

 

Red Bell 

The order has Business Rules Violations.  These violations were 
detected in Exchange Path and the order was stopped before it 
reached the Trading Partner. 

 

Red Hand 

The order has been canceled by the user or by the Trading Partner.  

 

 

White Check on Green Folder 

The order has been confirmed.  This means that the Trading Partner 
has accepted the order and is in the process of fulfilling the request.  

 

Red Exclamation Mark 

The order is in jeopardy.  This could be due to any number of reasons, 
from a delay in processing to a lack of resources. 

 

The following icons are not related to status changes. They allow the user to 
determine key information about an order via the icon . 

 

Train Tracks 

The order was placed outside the VFO system and the order within 
VFO is only being used for tracking purposes. 

 

United States Map 

This is a Multi-EC order, which means that the order has been placed 
through multiple Inter-Exchange Carriers.  

 

 This is indicating the order has a related purchase order.  

 



  

© 2022 Frontier Communications Parent, Inc. All rights reserved. 36 

View Last Notification 

You can link to the order in its most recent status by clicking the link in 
the Status column that corresponds to the order you want to view. 

NOTE:  You can open, view and modify multiple Access Orders 
simultaneously. 

 

Access Order Statuses 

Status Description User Action 

Accepted Access Provider (Trading Partner) has returned a positive 
acknowledgement. Exchange Path has updated the status, 
stored the message in the Exchange Path Database and 
sent a notification message to VFO. 

Wait for the FOC. 

Cancel Accepted The Trading Partner has returned a positive 
acknowledgement of canceling an ASR; Exchange Path has 
updated the status, stored the message in the Exchange 
Path Database, and sent a notification message to VFO. 

No action required.  

Cancel Rejected The Trading Partner has returned a negative rejection 
acknowledgment for a cancellation. 

View the Reject 
Reason and take 
the recommended 
action. 

Cancel Sent  A Cancel Request has been sent to the receiver/Trading 
Partner.  

No action required. 

Cancel Submitted A Cancel Request has been sent to Exchange Path for 
validation and subsequent processing. 

No action required. 

Cancel Tracked The Tracking Only Order has been cancelled. No action required. 

Clarification The Trading Partner has returned a Clarification message 

via the communications gateway.  Exchange Path has 
updated the status, stored the message in the Exchange 
Path Database, and sent a Clarification notification 
message to VFO. 

Review the 

Clarification 
message and take 
the recommended 
action. 

Clarification 
Cleared 

The Trading Partner has returned a Clarification Cleared 
message for the Access Order and Exchange Path has sent 
a notification message to VFO to update the status. 

No action required. 

Clarification 

Remarks 

The Trading Partner has returned a Clarification Remarks 

message (which is purely informational) for the Access 
Order and Exchange Path has sent a notification message 
to VFO to update the status. 

No action required. 

Completed The VFO user has manually updated the ASR status to 

Completed or a Trading Partner has sent a Completed 
Review Response 
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Status Description User Action 

clarification message.  This message is optional and not all 
Trading Partners support this notification. 

Confirmed The Trading Partner has returned a Confirmation message 

for the ASR; Exchange Path has updated the status, stored 
the message in the Exchange Path Database, and sent a 
notification message to VFO. 

Review Response 

DLR/Design The Trading Partner has returned a Design Layout Request 

(DLR) for the ASR; Exchange Path has updated the status, 
stored the message in the Exchange Path Database, and 
sent a notification message to VFO. 

Review Response 

Errored The ASR Order has failed the Exchange Path Validation 

process; Exchange Path has updated the Request Status, 
stored the ASR, and sent an Error Notification to VFO. 

Correct the Rule 

Error and Validate 
the Order again. 

Jeopardy Indicates there is a situation(s) that may jeopardize critical 
dates of the ASR Order. 

Review the 
Response and take 
the recommended 
action. 

Jeopardy with 
Errors 

Indicates there is a situation(s) that may jeopardize critical 
dates of the ASR Order and there is an error(s) with the 
request. 

Review the 
Response and take 
the recommended 
action. 

Pending 
Validation 

An initial request, or a change to a request, (other than a 
Cancel) has been created, but the request has not been 
sent to Exchange Path for validation or submission to the 
Trading Partner.  After select Submit or Validate the 
resulting response from Exchange Path will be Validated or 
Errored. 

Complete and 
Submit the order. 

Rejected The Trading Partner has returned a negative (rejection) 
acknowledgment. Exchange Path has updated the status, 
stored the message in the Exchange Path Database, and 
sent a notification message to VFO. 

Review the 
Response and take 
the recommended 
action. 

Resent The VFO user has requested that another copy of the last 
submitted version be sent to the Trading Partner.  

No action is 
required.  

Sent Exchange Path has sent the request to the Trading Partner, 
updated the status, and sent a notification message to VFO. 

No action is 
required.   

Submitted This message indicates that an initial request or a change 
to a request has been sent to Exchange Path for validation 
and subsequent processing.  This does not apply to a 
Cancel Request. 

No action is 
required.  

Supplement 
Received 

This status appears when the customer has sent a 
Supplement to the previously received Service Request. 

No action is 
required.  
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Status Description User Action 

TP Cancelled The provider has cancelled the customers ASR Order due 
to no response to the Clarification/Notification Request.  

If the order is still 
needed create a 
new request. 

TP Errored The Trading Partner has returned one or more error 

messages for the ASR Order. Exchange Path has updated 
the status, stored the message in the Exchange Path 
Database, and sent a notification message to VFO. 

Review the 

Response and take 
the recommended 
action. 

Tracked The order was initiated as a Tracking Only request and will 

not be transmitted to the Trading Partner.  This option is 
used when the order was sent outside of the VFO system; 
however, the progress of the order will be manually tracked 
in VFO. 

No action is 

required.  

Validated Exchange Path returns a validation successful message.  Submit Order 

Voided. The VFO user has placed the ASR in Voided status to 

indicate that the ASR should not be transmitted to the 
Trading Partner. 

No action is 

required. 

Note:  Any of these items can have "Inactive" appended to the status to indicate 
a user has selected to make the label the order as inactive. 

 

Create an Access Order 

Use the following procedure to create an Access Order: 

1.    Login to VFO and select the Access module. 

2.   Execute the Order > New menu command.  This opens the 
Order Initiation page. 

 

Figure 25: Order Initiation 
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3.   The Order Number field will be automatically populated with an 
incremented entry; however, the value can be changed 
manually.   

4.   Enter the Receiver Code.  Enter the entire Receiver Code or 
just the first characters of the Receiver Code, thereby filtering a 
dropdown menu from which to select required code.   The name 
of the Receiver Code appears to the right of the Receiver Code 
field and a list of the service center's guideline versions 
populate in the Guideline Version dropdown. 

5.   The guideline version is automatically populated by the system 
based on the Receiver Code picked by the user.  

6.   Select Firm Order from the Type of Request dropdown.  

7.    Select a Service.  This generates a list of activities available for 
the service type.  See options below. 

8.   Select an Activity. 

9.   Optionally, select a Template. 

10.  Click Initiate. This opens a new Order form. 

 

Figure 26: Access order page 

11. Populate the fields as necessary.  Yellow highlighted fields 
require data to be input in order to proceed to the next step.    

12. Validate the address without leaving the order by populating the 
address field and clicking the Validate link next to the section 
header. 
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Figure 27: Validate link for address detail 

The response for the above Address Validation would be anyone of 
the following: 

12a. Exact Match: 

If the values entered in the section have an exact match, 
then the below response will be displayed. 

 

Figure 28: Exact Match 

12b. Near Match: 

For all ASR Location inquiry responses, if the values 
entered in the section have one or more near matches, 
then the below response will be displayed with the list of 
all near match values. Users can select one of the 
addresses by clicking the Use Address button. This will 
pre-populate the ASR order address fields. 
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Figure 29: Near Match 

  

12c. No Match:  

If the values entered in the section has no match, then the 
below response will be displayed. 

 

Figure 30: No Match 

13. You can also validate the CFA by clicking the Validate link next 
to the CFA field name after populating that field.  
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Figure 31: Validate link for CFA query 

14. Browse through each of the remaining forms to ensure all 
required fields are populated. 

NOTE: Click the Save icon in the upper-right corner of the page if you 
intend to validate the order later.  

15. Click the Submit icon.  

16. Executing the Submit command validates the order against the 
business rules. You can also execute the Save, Submit, and 
Validate functions through the Order menu. 

Access Order Service Types 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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• 

• 

• 

 

 

Validate an Access Order 

The Validate command in VFO validates Access Orders against the 
business rules. The validation request is sent to the Business Rule 
Management System which performs initial validations, service 
provider business rule validations, and/or Trading Partner specific 
business rule validations. 

To validate an order, simply click the Validate icon . 

NOTE Executing the Submit command (by using the menu command or by 
clicking the Submit tool) automatically validates the Access Order.  

If any portion of the order fails validation, a window detailing the 
errors, by field, will appear. 

 

Figure 32: Validation error code list 

By clicking the link that appears in the Error Text column, the user will 
be taken to the first occurrence of that error.  
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NOTE: These errors only refer to specific fields.  If entire sections are in 
error, users will need to locate them manually. 

 

View Error List 

VFO allows you to view the errors that were found in an 
order.  Violated rules are displayed in the Error Code List in a pop-up 
browser. 

To view the errors, open the Access Order and execute the Order > 
View > View Error List menu command. 

This same command can be used to view the errors from the Trading 
Partner.  TP Errored and Rejected statuses will generate an Error List 
of the fields the Trading Partner rejected or required.  Some of these 
errors will link to field when clicked.  Others will need to be navigated 
to manually.  This behavior is dependent on how the field is returned 
by the Trading Partner. 

You must Supplement the order before you can correct the errors. 

Access Four-Step Ordering Process 

The VFO Access Four-Step Ordering Process allows you to send an 
Access Order as an Inquiry before you send it as a Firm Order.  

Use the following procedure to perform a Four Step Order.  

1.    Begin creating a new Access order as usual.   (Order > New) 

2.   Select Service Inquiry (Manual/Mechanized) or Service Inquiry 
(Follow-up to Verbal) from the Type of Request dropdown. 

  

Figure 33: Four Step Order Initiation 

This drives the second character of the REQTYP.   

A = Manual/mechanized  

G = Access Service Request follow up to verbal 

3.   Submit the order. 
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4.   Once you receive a response from the Trading Partner, click the 
PON link of that Response. 

5.    In the resulting pop-up window, use the Order > Action > 
Convert to Firm Order menu functionality. This drives the 
second character of the REQTYP.   

C = Manual/Mechanized  

J = Access Service Request follow up to verbal 

6.   Make any changes necessary and submit the new Firm Order.  

You can still execute the Save, Submit, and Validate functions through 
the Order menu. 

 

Search Access Orders 

The VFO Search functionality allows you to search all Access Orders 
for the occurrence of specific values.  You can extend your search by 
using the wildcard (%) character.  

Use the following procedure to find a specific Access Order(s):  

1.    On the Order List page, execute the Order > Search menu 
command.  This opens the Search dialog, as shown below. 

 

Figure 34: Search page 

2.   Select the criterion from the Search On list.  

3.   Enter the value you wish to search for in the Search For 
field.  This field is not case sensitive. 

4.   Click Search.  

Many of the fields in the search criteria list start with the ASR form 
where the field resides.  For example, “Transport Connecting Facility 
Assignment,” is the CFA field on the Transport form.  Below are the 
values that appear without the form noted: 

Search On Value Location on Access Order 

ACTL ASR form>Administrative>ACTL field 

ASR Number Appears on responses from receiver. 

Bandwidth 
Confirmation EVC Circuit ID 

Gen. Info form 
Confirmation form 
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Search On Value Location on Access Order 

911 Gen. Info form 

Initiator ASR form> Contact section> INIT field 

Market Gen. Info form 

Mobile Technology Gen. Info form 

Multi-EC Order Multi-EC form 

Other Exchange Company Multi-EC form> Other Exchange Company section> ICSC field 

Project Code 1 Gen. Info form 

Project Code 2 Gen. Info form 

Project Code 3 Gen. Info form 

Protected Circuit Gen. Info form 

Provider Name Gen. Info form 

Purchase Order  ASR form 

Region Gen. Info form 

Related Purchase Order Number 
(RPON/CCNA) 

ASR form 

Served By Fiber Gen. Info form 

NOTE:  The Gen. Info form was created to provide companies with a form to enter 
information for internal use only.  Please check with your company to see 
which fields your company wants you to use and the information that 
should be entered.  The information on this form is not sent to the 
Receiver of the Access request.   

 

Filter Access Order List 

The Filter function allows you to limit the selection of orders displayed 
in the Order List.  You can save the filter settings and apply them to 
future sessions.  Your Order List filter settings will open as part of the 
login process.  

Use the following procedure to filter the Access Order List: 

1.    At the Order List page, click the Filter icon.  

2.   This opens the Order List Filter window.  Below are some of the 
field descriptions.   
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Figure 35: Order list filter 

 

• Receiver Code:  This is the code used to identify the 
Trading Partner (i.e., Interexchange Customer Service 
Center or ICSC code or OEC in the order). 

• Customer Code:  Filters the orders based on the code used 
to identify the sender of the order request (i.e., Customer 
Carrier Name Abbreviation, CCNA). 

• Public Search:  When checked, all orders will be listed or 
those for a selected Initiator.  When unchecked, only orders 
placed by the user will be displayed. 

• Owner:  During a Public Search, the orders can be filtered 
by a specific Owner by selecting a user from the drop-down 
menu. 

• Display Group:  A group of users.  Administrators can set 
up Display Groups and associating users to those groups. 

• Due Date:  These fields can be used to find orders within a 
due date range. 

• Date Sent/Received:  These fields can be used to limit the 
range of the orders based on the date sent or received.  

      Service:  Filters the results by the service being performed. 

      Type of Request:  Filters the results by the type of request: 

o     Firm Order 

o     Firm Order (Follow-Up to Verbal) 

o     Firm Order (Manual/Mechanized) 
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o     Service Inquiry (Follow-Up to Verbal) 

o     Service Inquiry (Manual/Mechanized) 

      Activity:  Filters by the kind of order that has been placed. 

      Guideline Version:  Filters by the Guideline Version that 
the order has followed. 

      Direction:  Filters the Order List based on whether the 
orders were Sent or Received. 

• Work Centers: Filters the Order List based on Work Center 

• Work Groups: Filters the Order List based on Work Group 

• State:  This field may be populated with the states supported 
by the user’s company.  See your Sales Associate for details. 

• Include Inactive Orders:  By default, orders that are made 
“Inactive” will not show on the Order List.  If you want them 
to show in the list, select this check box. 

• Tracking Orders:  Select this check box to narrow the list to 
just orders entered for tracking purposes only.  This are 
100% manual transactions; nothing is sent to the Receiving 
Trading Partner. 

• Multi-EC Orders:  Select this check box to narrow the list of 
order to those involving multiple exchange carriers. 

• RPON Orders: Filters the Order List based on PONs with the 
RPON field populated. 

      Status Fields:  Lists all the possible statuses. 

3.   Select the items you want displayed on your Order List, or 
check the Exclude box, which allows you to display all items 
except the items you have checked.  

4.   By clicking the checkbox next to the header of a subsection, you 
select all the statuses within it. 

5.    Some of the available filter options may be minimized into their 
headers.  By clicking the blue downward arrow  you can open 
these sections up.  Minimizing them is accomplished by clicking 
the upward facing arrow. 

6.   Click OK.  The Order List results will only contain the items 
matching your selections. 

New VFO users signing in for the first time will have the filter default to 
their orders. This will return a blank Order List with the message “No 
Records Found”.  The users can then reset their filter as needed.   

NOTE: Click the Clear button on the Order List Filter window to erase all 
previous selections.  Make your selection and click OK to return to 
the list and view the new filter results. 
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 The filter selections remain the same from log on to log off until 
changed. 

 

Using the History Function 

View the History 

Use the following procedure to view the history of an Access Order.  

1.    Log into the Access module.  VFO opens on the Order List 
page.  

2.   Click the History icon (the icon that looks like an open 
book).  This opens the Order History page where you can view 
and print the history of the selected Access Order.   Alternately, 
users can use the Order > View History menu functionality, after 
selecting the order with the radio button, to open the Order 
History page. 

 

Figure 36:  Order history 

 

NOTE: If the History is opened from within an Order, users will see a 
return to order icon.  This icon allows users to return to the 
previous window. 

3.   Click View XML to show the XML, which will be or was sent to 
Exchange Path after the user clicked Validate and/or Submit. 

4.   Click the Download XML icon to download the Request XML 
and all the associated response XMLs in a single zip file.  The 
zip file name will be PON_Version.zip. 

 

Access Supplement 

VFO allows the user to supplement information to an order that has 
already been submitted.  These supplements, as well as the numbers 
used to identify them, are as follows: 

      1-Cancel 

      2-New Desired Due Date 
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      3/4-Other (Change After/Before FOC) 

 

Figure 37: Order Supplement Icons 

 

In order to supplement a service request, it must have a status of Sent 
or any response other than Complete from the provider.  

Use the following steps to supplement an order: 

1.    Select an order from the Order List by clicking the PON. 

2.   Hover over the Order menu and select the Supplement option. 
Alternately you can click the number, in the upper right-hand 
corner, that corresponds with the Supplement you wish to 
perform. 

NOTE: When other changes are being made, you can select icon 3/4 and the system will 
select Sup Type 3 or 4 based on the status of the order. 

3. If the order has an alphanumeric or alpha version, a window will 
appear for the user to enter an incremented version and then 
click Change. 

   

Figure 38: Supplement change version page 

 

4.  If you perform a Cancel Supplement you will be asked to 
confirm the action. 

5.   If you perform a New Desired Due Date Supplement, the 
following image will pop up. 
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Figure 39: Desired due date change 

 

6.  Click the Calendar icon to the right of the DDD field to select 
available dates for the new DDD. 

7.  Click Change to apply the changed DDD to the order. 

8. If you perform a Supplement Others and do a change before 
FOC or a change after FOC, the order window will display the 
current order and allow you to change the fields. 

9.   Click within the Remarks field and explain the purpose of the 
Supplement order. 

10. Click Submit. 

 

If VFO does not find a Firm Order Confirmation on the PON that is being 
supplemented, the error message “Supplements to change the due date are 
only valid for requests which have a firm order confirmation” will be 
displayed and users will be prevented from submitting the SUP 2.  

Switch certain Service types on Supplements 

 Once an initial version of a Transport EVC or an End User EVC (i.e., combo) 
ASR is submitted to the TP, VFO users will be able to convert them to 
UNI/NNI service types via supplement functionality.  

 This can be done by doing a SUP 3 or 4 on version 2 of the order and 
selecting “Convert to UNI/NNI Service type” option. 
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Figure 40: Convert to UNI/NNI Service Type 

 

Note: This option will not be displayed while doing a DDD change or 
cancelling the order. 

After conversion, the service type of an End User EVC ASR will change to 
EUSA 2 Point.  Likewise, the service type of a Transport EVC ASR will 
change to SA 2 Point after conversion.  No other service type changes will 
be allowed via the supplement functionality.  Users will need to do a 
cancel/reissue for other service type changes.  

By selecting the above option, ASR.EVCI field is disabled and will be auto 
populated by VFO based on the service type selected by the User as follows : 

If SERVICETYPE IS: THEN ASR:EVCI IS: 

Transport EVC B 

End User EVC B 

Standalone EVC A 

All other servicetypes blank 

Cancel Order Details 

A Cancel Order is treated as a Supplement to the original Access 
Order. Canceling an Access Order does not delete it from the VFO 
database or affect any Supplements.  

The Cancel Order function is enabled for the following statuses:  

      Accepted 

      Clarification 

      Confirmed 

      Errored 
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      TP Errored 

      Validated 

 

The Cancel Order is disabled when the following conditions are met:  

      Access Order was never submitted 

      Access Response status is: 

o     Cancel Accepted 

o     Cancel Rejected 

o     Cancel Sent 

o     Cancel Submitted 

 

Visual Notification for RPON 

If the original ASR has the RPON field populated, an alert will be generated 
by VFO when the user modifies an Access Order (i.e., initiates a supplement 
request) after successfully submitting it. 

 
1. VFO user logs in and initiates a sup against an ASR that was previously 

submitted to the TP. 
 

2. If the ASR.ADMIN.RPON field is populated in the version that is being 
supp’ed, a pop-up window is displayed with the following alert: “The PON 
you reverted to/are supplementing has an RPON associated with it.”  
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                           Figure 41: RPON Visual Notification – ASR 

3. Users may click the OK button and proceed with supplementing the order. 
 
4. SUP pop-up window is displayed, user proceeds with populating the 

Version field and clicks the Change button. 

Visual Indicator for RPON 

If an access order has an associated RPON field populated, then an icon ‘R’ 
will be displayed in the Order list. In the event there is more than one 
version for a PON, the RPON icon will be displayed if the latest version has 
the RPON field populated. 

 

Figure 42:  Visual Indication for RPON 
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Revert to Last Submitted 

If you modify an Access Order after you successfully submitted it (i.e., 
started a Supplement request), you can back out the changes to the VER 
and SUP fields and return to the previously submitted status of the Access 
Order by executing the Order > Revert > Revert to Last Submitted 
command.  This command restores the previously submitted version of the 
Request even if you executed the Save command to save those changes.   
This function is only available before the Supplement is submitted. 

Revert to Last Saved 

If you are entering values into the fields of an Access Order and then 
decide to return to the previously saved version of the Access Order, 
execute the Order > Revert > Revert to Last Saved menu command.  

NOTE: This goes back to the data that was saved before the current saved 
data. So, after you save the data, you can use this command to 
revert to the way the order was before you made changes and hit 
SAVE a second time. 

If the ASR.ADMIN.RPON field is populated in the version that is being 
supp’ed and was reverted, a new pop-up window is displayed with the 
following alert: 

“The PON you reverted to/are supplementing has an RPON associated with 
it”. 

Save As an Access Request 

VFO allows you to save a copy of a selected or current Access Order 
under a different PON.  You can execute the Save As command from 
the Order List page or from within an existing Access Order.  

This can be performed on both ASOG and Non-ASOG orders. 

Use the following procedure to Save As or copy an existing Access 
order. 

NOTE: If you are doing a Save As from the Order List page, you must first 
click the radio button of the order you want to copy.  

1.    If performing the action from the Work List, use the Order > 
Save As Order menu command.  If performing it from within the 
order itself, use the Order > Action > Save As Order menu 
command.  This opens the Save As New Order window. 
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Figure 43:  Save as new order 

 

2.   Enter a new, unique PON. 

3.   Optionally, select a new Receiver Code and change the activity. 

4.   Click Save.  

 

Void Service Requests 

VFO allows you to void a Service Request for any reason, if the 
Service Request has not been sent to the Trading Partner. This also 
includes orders that have been submitted but received a System Error.  

When the initial orders have been Rejected by the Trading Partner, 
the order can be voided in VFO.  However, if the order has been 
supplemented it cannot be voided.  

To void a Service Request: 

1. Open the Service Request. 

2. Hover the Order tab. 

3. Click the Void menu command. 

Inactivate and Activate Orders 

All active orders created in the application are displayed in the Order 
List by default.  Orders are considered Active unless a user specifies 
otherwise.   

The only orders not displayed with the default filter are "Inactive" 
orders, however you can choose to include those orders in the Order 
list by checking the check box "Include Inactive Orders" in the filter. 
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Inactivating Orders   

Orders became "Inactive" when a user applies this label to the order. 
To indicate an order is inactive the user: 

1. Opens the service request by clicking the PON in the Order list. 

2. Hovers over the Order tab. 

3. Selects the menu options Edit > Inactivate Order.  

4. The status of the order will be appended with the word 
"/Inactive." 

NOTE:  If a response is received on an “Inactive” order, the system will automatically 
set the order as active and remove the “/Inactive” notation in the status and 
depending on the filter criteria, show the order on the Order list. 

Activating Orders 

To make an Inactive order Active: 

1. Click the PON in the Order list to open the service request. 

2. Hover your mouse over the Order tab. 

3. Select the menu options Edit > Activate Order. 

The "/Inactive" text will be removed from the order status and it will 
appear on the Order list when the default filter criteria are used.   

 

VFO allows Users to Update the Access Request General 
Information 

When a Trading Partner sends a Completion Notification, the Carrier 
or customer often has work to do before the service can be turned 
up.  VFO allows users to add or update the customer “Completion 
Date” field, as well as other data on the General Information form.  

Use the following procedure to update the General Info tab: 

1.    Click the PON to open the ASR. 

2.   Execute the Order > Edit > Update Custom Form command.  

3.   In the Completion Date box, click the Calendar icon.  

4.   Select the new Completion Date and click Change. 
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This section reviews the following: 

• Creating Templates 

• Saving Templates 

• Applying Templates after Order Initiation 

• Searching for a Template 

 

Create a Template 

Templates use common data values to pre-populate orders, thereby 
reducing, or eliminating redundant data entry and reduce errors.  VFO 
lets you tailor your own templates for every type of Service Request, 
as well as giving you the ability to modify, update, or delete an 
existing template from VFO. 

Use the following procedure to create a template: 

1.    Log into VFO and select a module.  This opens the Order List 
page. 

2.   Hover your cursor over the Template tab.  This reveals the 
Template menu. 

3.   Execute the Template > New menu command.  This opens the 
Template Initiation page.   

 

Figure 44: Template initiation 

 

     Template Name — Enter a user-defined, unique name for 
the template.  

     Template Description — Enter a user-defined value that 
describes the template. 
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      Trading Partner — Select a Service Provider to display 
their available Service Centers. 

      Service Center — Select a Service Center to generate a 
list of their available versions. 

     Guideline Version — Select a version. 

     Service — Click this dropdown menu to select the Service 
Type for the negotiation of Service Request. 

     Activity — Click this dropdown menu to identify the activity 
involved in this service request  

     Initiate — Click this button to submit the values entered on 
this page and add the new template to the list of available 
templates. 

     Cancel — Click this button to ignore the values entered on 
this page and return to the Order List page. 

4.   Populate the Template Initiation page. 

5.    Click Initiate.  This opens a shell of an order. 

6.   Populate the fields with common data values that, when 
selected, will pre-populate a new form.  

7.    Browse through each of the remaining forms and repeat step 6. 

8.   Click the Save icon in the upper-right corner of the page.  This 
saves the values to the database. 

 

Save As Template 

Another way to create a template is to execute the Save As Template 
menu command.  This command is available in the Order menu on the 
Order List page and in the Order menu on the Service Request. 

Use the following procedure to save a Service Request as a template:  

1.    If you are on the Order List page, click the radio button of the 
Service Request you want saved as a template and execute the 
Order > Action > Save As Template menu command.  

2.   If you are in the Service Request, execute the Order > Action > 
Save As Template menu command.  

Either of these commands opens the Saved Order as a new template. 

3.   Enter a unique value in the Template Name field.  

4.   Click Save. 
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Apply Template after Order Initiation 

The Apply Template command populates blank fields of a Service 
Request with the respective values of the selected template.  

Use the following procedure to apply a template from within a Service 
Request Order form: 

1.    Initiate a Service Request. 

2.   Execute the Order > Edit > Apply Template menu command. 
This opens the Apply Template window. 

3.   Select the desired template from the dropdown menu. 

4.   Click OK. 

Search for a Template 

Use the following procedure to search for a template.  

1.    Log into VFO and select the module.  This opens the Order List 
page. 

2.   Hover your cursor over the Template tab.  This reveals the 
Template menu. 

3.   Execute the Template > Search menu command.  This opens 
the Template List page, which lists all available templates.  

 

Figure 45: Template list 

 

    TemplateName — Enter the name of the template and click Go 
or click the template name link. 
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    Trading Partner — Enter the value that identifies the service 
provider in this service request and click Go to search on that 
value. 

    ServiceType — Enter the value that identifies the type of 
service and click Go to search on that value. 

    Activity — Enter the value that identifies the activity involved in 
searched service request and click Go to search on that value. 

      Delete — Click a radio button(s) that corresponds to the 
template you wish to remove.  Then click the red X in the upper 
right corner of the page to remove a template from the Template 
List and from the database. 

      Go — Click this button to submit the search criteria entered on 
the page to the Template database. 

      Clear — Click this button to remove search criteria from the 
fields on the Template List page. 

NOTE: Executing the Clear command does not clear radio button 
selections. 
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This section explains the procedures for performing the following tasks: 

• Performing Local PreOrder Inquiries 

• Saving Local PreOrder Response 

• Printing Local PreOrder Response 

• Searching Local PreOrder Responses 

• Printing Local PreOrder Search Results 

• Validating PreOrder Business Rules 

 

Local PreOrder Inquiry Procedure 

WARNING: You will notice an error if you have not been configured to use the 
PreOrder functionality. 

Use the following procedure to perform a new PreOrder Inquiry.  

1.    Log into VFO and select the Local module. The Order List page 
opens. 

2.   Execute the PreOrder>New menu command. The PreOrder 
Initiation window opens. 

 

Figure 46: Preorder initiation 

 

      TXNUM: This will be automatically populated with an 
incremented entry. Optionally, you can change the value in the 
TXNUM field manually. 

      Trading Partner: This dropdown will contain all the Trading 
Partners that have been configured for use in this module.  
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      Service Center: The options listed will be determined by the 
choice of Trading Partners.  

      TX Type: The Transaction Type will be determined based on 
the selected Service Center. 

3.   Click Initiate. This opens the PreOrder Request window. 

 

Figure 47: Address validation 

 

4.   Populate the fields with relevant search criteria. Yellow fields 
are required. 

5.    Click Submit. The returns are displayed in the PreOrder 
Response window. 

For large responses, to view the entire response you may need 
to use the pagination provided for each section containing more 
than 10 items. 

 

Figure 48: PreOrder pagination 

Enter the number of records you want displayed at any one time 
for that section and click the SHOW link.  The default is to show 
up to 10 items at a time before needing to move to the next 
page. 

Click the outside arrows to move to the first or last page. 

Click the inside arrows to move page by page. To modify the 
PreOrder Request, click the Inquiry tab.  This re-opens the 
PreOrder Request. 

6.    If you want to modify the PreOrder Request, click the Inquiry 
tab. This reopens the PreOrder Request. 
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7.    Click the Change button to edit fields.  

8.   Make the desired changes and click Submit to resubmit the 
PreOrder Inquiry. 

 

Save Local PreOrder Response 

VFO allows you to store the PreOrder Inquiry and Response 
transactions.  

Use the following procedure to save Inquiry and Response 
transactions. 

1.    Execute a PreOrder Inquiry. Make sure you are in the PreOrder 
Response window. 

2.   Scroll to the bottom of the window and click Save. 

 

Print Local PreOrder Response 

Use the following procedure to print from the PreOrder List.  

1.    Execute a PreOrder Inquiry. Make sure you are in the PreOrder 
Response window.  

2.   Click Printable Version to open a new window with a version of 
the Response that is better formatted for a printer.  

3.   Click Print. The Print dialog box opens allowing you to print 
based on your print configuration.  

 

Search Local PreOrder Responses 

VFO allows you to view the details of a previously completed PreOrder 
Response. 

 Use the following procedure to view PreOrder Response details.  

1.    Log into VFO and select the Local module. The Local Order List 
page opens. 

2.   Hover your cursor over the PreOrder tab. A dropdown menu 
opens. 

3.   Execute the PreOrder > Search menu command. The PreOrder 
Search page opens. 

4.   Users can perform the search using the following criteria: 

      TXNUM: This number was either generated by the system 
or by the user.  Using this field is the most direct way of 
locating a PreOrder. 
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      Trading Partner: This dropdown will contain all the Trading 
Partners that have been configured for use in this module. 

      TX Type: The Transaction Type will be determined by the 
selected Service Center. 

      TX From Date and TX To Date: These fields define the 
beginning and the end dates for the search. 

      Go: Click this button to submit the search criteria and view 
the returns. 

      Clear: Click this button to refresh the screen and empty all 
the populated fields. 

5.    Enter the appropriate search criteria. 

6.   Click Go. The results will display in the bottom half of the 
window. 

 

Validating PreOrder Business Rules 

The SUBMIT command in VFO validates and submits LSR Pre-Orders 
against business rules. The validation request is sent to the Business 
Rule Management System which performs initial validations, service 
provider business rule validations, and ILEC specific business rule 
validations. 

NOTE: Executing the Submit command (by clicking the Submit button) 
automatically validates the Service Request. 

Use the following procedure to validate and submit a  service request. 

1. Initiate a new pre-order query. 

2. Populate necessary fields. 

3. Click the Submit button.  

 

Figure 49 : PreOrder Validation 
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4. Business rule errors are displayed to the user accordingly, when 
applicable. 

This section reviews the following: 

• Local Service Request Work List 

• Creating Local Service Orders 

• Validating Local Service Orders 

• Supplementing Local Service Requests 

• Searching Local Service Requests 

• Filtering Local Service Request Order List 

• Using the Save As command 

• Supplement Vs. Resubmit Original Order 

• Viewing the History 

• Reverting to Last Saved 

• Reverting to Last Submitted 

• Viewing Error List 

• Viewing Last Notification 

• Voiding Orders 

• Generating a Printable Version 

 

Local Service Request Work List 

The Order List houses all the Local orders created in the application 
and all the responses received.   

• The PON is a link to the order detail in read/write mode.   

• The Version is a link to a read only view of the order.   

• The Status is a link to the response details returned from the 
Trading Partner. 

Orders that have been reassigned to a new owner are displayed with a 
darker shade of gray.  Orders with the Owner’s name shaded pink 
indicates that the owner has been deleted from the application.   
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Local Module Specific Action Icons 

Clipboard 

This icon allows users to generate a Summary of all the Responses 
from a particular order.  Please note that this icon is unique to Local 
Orders. 

 

Work Status Icons 

There may be an icon beside some of the Orders to indicate different 
work states. Following are what these icons indicate:  

Flame 

Order has been rejected by the Trading Partner. This is not due to 
Business Rule violations, as those would result in a different icon. 

 

Green Check Mark 

Order has been completed by the Trading Partner.  

 

 

Red Bell 

Order has Business Rules Violations. The violation(s) was detected in 
Exchange Path and stopped before it reached the Trading Partner. 

 

White Check on Green Folder 

Order has been confirmed. This means that the Trading Partner has 
accepted the order and is in the process of fulfilling it.  

 

Red Exclamation Mark 

Order is in Jeopardy. This could be due to any number of reasons , 
from a delay in a process required to a lack of resources.  

 

Red Hand 

The order has received a Directory Service Confirmation & Error 
Detail. 

 

Train Tracks 

Order is Tracking Only. This means that the order was placed outside 
the VFO system and the information within VFO is simply used for 
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tracking purposed. Please note that this status is not related to status 
changes. 
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Create a Local Service Order 

Use the following procedure to create a Local Service Request order.  

1.    Login to VFO and select the Local module. This opens the 
Local Order List page.  

2.   Hover your cursor over the Order tab. This reveals the Order 
menu. 

3.   Execute the Order > New menu command. This opens the Order 
Initiation page. 

 

 

Figure 50: Local order initiation page 

 

4.  If the CLEC is configured for OCN functionality, then the below 
page will appear.      

 

Figure 51: Local order initiation page 
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5. The system will generate an Order number.  Users can enter a 
different Order number, if they choose to do so. 

6.    Select a Trading Partner. This generates the Trading Partner's 
Receiver Code and the guideline version supported. 

7.     Enter a new Version value or leave the system generated 
version. 

8.   Select the OCN (only for OCN configured CLECs) from the list, 
the first OCN code from the dropdown will be the primary and 
the rest will be secondary. The OCN selected on the Initiation 
page will be pre-populated on to the CC field on the LSR form. 

9. Select a Service. This generates a list of activities available for 
that service. 

10.  Select an Activity. 

11.   Optionally, select a Template. 

12. Click Initiate. This opens a new Service Request Order form. 

 

Figure 52: LSR order page 

13. Populate the fields. If a section is required, its header will display 
the word Required.  At a minimum, fields within that section are 
required, they will be highlighted in yellow.  Additional fields may 
be required as per the type of request. 

14. The address can be validated without leaving the order by 
populating the address field and clicking the Validate link next to 
the section header. 



  

© 2022 Frontier Communications Parent, Inc. All rights reserved. 73 

 

Figure 53: Address Validation for LSOG UOM10 

The response for the above Address Validation may be any of the 
following: 

14.a Exact Match:  If the values entered in the section have an 
exact match, then the below response will be displayed.  

 

Figure 54: Exact Match 

14.b Near Match:  For LSOG UOM customers, if the values entered 
in the section have one or more near address matches, then 
the below response will be displayed with the list of all near 
match values. Users can select one of the addresses by 
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clicking the Use Address button. This will pre-populate the 
LSR order address fields.  

 

Figure 55: Near Match for LSOG UOM10 

14.c No Match: If the values entered in the section have no match, 
then the below response will be displayed. 

 

Figure 56: No Match 

15. Browse through each of the remaining forms and repeat the 
previous step. 

NOTE: Click the Save icon in the upper-right corner of the page if you 
intend to validate or submit the order later.  
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16. Click the Submit icon. Executing the Submit command 
validates the service request order against the business rules.  

NOTE: You can also Save, Submit, and Validate by clicking the Order tab 
and executing that function through the menu command. 

Validate a Local Service Order 

The Validate command in VFO validates Service Request Orders 
against the business rules. The validation request is sent to the 
Business Rule Management System which performs initial validations, 
service provider business rule validations, and ILEC specific business 
rule validations. 

NOTE: Executing the Submit command (by using the menu command or by 
clicking the Submit tool) automatically validates the Service 
Request. 

Use the following procedure to validate a service request.  

1.    Click the link in the PON column, on the Order List page, to 
open the applicable Service Request. This opens the Service 
Request order. 

2.   Click the Validate icon in the upper right corner of the page or 
execute the Order > Validate menu command. Violated rules are 
displayed in the Error Code List window. 

 

Figure 57: Error code list 

3.   Click the link in the Error Text column. This links you to the 
violated field. 
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NOTE: The errors in the figure above only refer to specific fields.   If entire 
forms or sections are in error, users will need to manually navigate to 
the form or section to make corrections. 

4.   Refer to the Form and Section/Field columns to determine the 
location of the violating field. Refer to the Occurs column to 
determine how many occurrences of the violation are in the 
Request. 

5.    Make the required changes.  

6.   Click Save. 

 

View Error List 

VFO allows you to view the errors that were found in the Order. 
Violated rules are displayed in the Error Code List in a pop-up 
browser. 

Open the Service Request and execute the Order > View > View Error 
List menu command to view the errors. 

Some of these errors will link to fields when clicked. Others will need 
to be navigated to manually.  

 

Local Service Request Supplement 

VFO allows you to supplement Local Service Requests.  

1.  Hover the Order tab. 

2.  Select the Supplement menu command 

3.  If the LSR RPON field is populated in the version that is being 
supp’ed, a new pop-up window is displayed with the following alert: 
“The PON you reverted to/are supplementing has an RPON 
associated with it.” 

4.  If the version is Alpha or Alphanumeric, you will be presented with 
a page to increment the Version and select a Supplement Type.  

 

Figure 58: Supplement new version 
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5.  If the version is numeric, you will be presented with the same page, 
but the system will increment the version for you. 

Tracking Local Service Requests 

Tracking is only to be used if your request is not to be submitted to the 
Trading Partner.  Tracked orders are visible only on the customer’s 
order list.  

Search Local Service Requests 

VFO's Search functionality allows you to search for every occurrence 
of specific values in Service Requests. You can extend your search by 
using the wildcard (%) character.  

Use the following procedure to find specific Service Requests.  

1.    On the Order List page, execute the Order > Search menu 
command. This opens the Search dialog. 

 

Figure 59: Search page 

2.   Select the criterion on which you want to search. 

3.   Enter the value you wish to search for in the Search For field. 
This field is not case sensitive. 

4.   Click Search.  

 

Filter Local Service Request Order List 

The Filter function allows you to limit the selection of orders displayed 
in the Order List. The system saves your filter settings and applies 
them to future VFO sessions. Your Order List filter settings will open 
as part of the login process.  

Use the following procedure to filter the Local Order List.  

1.    At the Order List page, click Filter (the icon that resembles a 
funnel). This opens the Order List Filter window. 
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Figure 60: Order list filter 

2.   Select the items you want displayed on your Order List, or 
check the Exclude checkbox, which allows you to display all 
items except the items you have checked. 

3.   Click OK. The resulting Order List only contains the items 
matching your selections. 

4.   By clicking the checkbox next to the header of a subsection, 
you select all the statuses within it.  

5.    Some of the available filter options may be minimized into their 
headers. By clicking the blue downward arrow  you can open 
these sections up. Minimizing them is accomplished by clicking 
the upward facing arrow.    

NOTE: Click the Clear button the Order List Filter window to erase all 
previous selections. 
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Below is a list of the statuses included in the Filter and their meaning: 

Status Description User Action 

Acknowledged - 
Accepted 

The request has passed the TP initial 
validation of the request. 

Wait for Confirmation 

Acknowledged – 
Rejected 

The request could not be processed by the 
TP’s initial system. 

Contact your System 
Administrator 

Acknowledged – 
Error  

The request has failed the TP initial validation 
of the request.  

Review error and take 
recommended action 

Billing 
Completed 

TP has completed the billing process and will 
be generating a bill for services rendered. 

No action required 

Confirmed TP has returned a confirmation message for 
that LSR. 

Review Response 

Cancel 
Confirmed 

The Trading Partner has confirmed canceling 
an LSR; Exchange Path has updated the 
status, stored the message in the Exchange 
Path Database, and sent a notification 
message to VFO. 

No action required. 

Cancel Rejected 

(Non-Fatal) 

The Trading Partner has returned a negative 

rejection acknowledgment for a cancellation. 
This reject is not fatal to the request and in 
most cases, you can supplement the request to 
correct the error. 

View the Reject Reason 

and take the 
recommended action. 

Cancel Rejected 
(Fatal) 

The Trading Partner has returned a negative 
rejection acknowledgment for a cancellation. 
This reject is fatal to the request and in most 
cases, you cannot supplement the request to 
correct the errors. 

View the Reject Reason 
and take the 
recommended action. 

Errored LSR has failed the Exchange Path validation 

process. 

Correct Rule Error and 

Validate again 

Jeopardy Indicates there are situations that may 

jeopardize critical dates of the LSR (PON). 

Review Response and 

take recommended 
action 

Pending 
Submission 

The VFO application is unable to communicate 
with the gateway application.  As soon as 
communication is restored, the request will be 
sent. 

Contact your system 
administrator 
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Status Description User Action 

Pending 
Validation 

An initial request or a change to a request has 
not been sent to Exchange Path for validation 
or submission to the Trading Partner. After 
validation, the resulting response from 
Exchange Path will be Validated or Errored. 

Complete the order, 
validate and submit 
request 

Provisioning 

Completed 

TP has completed the provisioning of the 

service. 
No action required 

Rejected (Non-

Fatal) 

TP has returned a negative (rejection) 

acknowledgment.   This reject is not fatal to 
the request and in most cases, you can 
supplement the request to correct the error.  

Review Response and 

take recommended 
action 

Rejected (Fatal) TP has returned a negative (rejection) 

acknowledgment that is fatal to this 
request.  In most cases, you cannot 
supplement the request to correct the errors. 

Review Response and 

take recommended 
action 

Sent Exchange Path has sent the request to the TP, 

updated the status, and sent a notification 
message to VFO. 

No Action 

Submitted This message indicates that an initial request 
or a change to a request has been sent to 
Exchange Path for validation and subsequent 
processing.  As soon as the request is 
electronically processed, the status will change 
to “Sent.” 

No Action 

System Errored VFO has received a system error message 
from Exchange Path. 

Read the error and 
Submit Order again. 
Contact your System 
Administrator to alert 
them of the issue if it 
continues. 

Tracked The order was initiated as a Tracking Only 
request and will not be transmitted to the 
Trading Partner. This is used when the order 
was sent manually outside of VFO and you 
want to track the order progress manually in 
VFO. 

No Action 

Validated Exchange Path returns a validation successful 
message. 

Submit Order 

Voided VFO user has placed the LSR in this status 
to indicate that this request should not be 
transmitted to the Trading Partner. 

No Action 
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View Last Notification 

You can link to the Order in its most recent status by clicking the link 
in the Status column that corresponds to the Order you want to view.  

Generate Local Service Request Response Summary Report 

After a Service Request receives a Response, you can use the 
Summary Report to view the key information provided in that 
response. For example, after you receive a Firm Order Confirmation, 
the Summary Report will detail the Due Date information based on the 
Response. The Summary Report function is enabled for the following 
statuses:  

Acknowledged Provisioning 
Completed 

Rejected (Fatal) 

Confirmed Billing Completed Jeopardy 

Rejected (Non-fatal) Confirmation  

 

Use the following procedure to generate a Response Summary 
Report. 

1.    Check the checkbox of the PON for which you will generate a 
Summary Report. 

2.   Click the Summary icon, , on the Local Order List page. 

 

Figure 61: Response summary report 

3.   Optionally click the Print button to print the Response Summary 
Report. 

View the History 

Use the following procedure to view the history of a Service Request 
order. 

1.    Log into Local module. VFO opens on the Order List page.  

2.   Click the radio button that corresponds to the desired Order.  

3.   Click the History icon. This opens the Order History page where 
you can view and print the history of the selected Service 
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Request. You can also download the XML generated for each 
item in the Order History screen. 

 

Figure 62: Order history 

 

Save As a Local Service Request 

VFO allows you to save a copy of the selected or current Service 
Request under a different PON. You can execute the Save As 
command from the Order List page or from within an existing Service 
Request. 

Use the following procedure to save an existing Local Request as 
another Local Request. 

NOTE: If you are using the Save-as command from the Order List page, 
you must first click the radio button of the order you want to copy.  

1.    Execute the Order > Save As Order menu command. This 
opens the Save as New Order window. 

 

Figure 63: Save as new order 

2.   Enter the new, unique PON. 

3.   Click Save. 
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If you are performing a Save As from within an existing Service 
Request, open the Service Request you want to copy and execute the 
Order > Action > Save As Order menu command. 

 

Supplement Orders 

If you need to send another version of the order to indicate a change, 
you will use the Supplement function. 

1. Execute the Order > Supplement menu command or click the 
Supplement icon, displayed as “Sup” in a circle. 

  

Figure 64: Supplement LSR Order 

 

2. Indicate a version (if not auto populated) and supplement type. 

 

Figure 65: Supplement others version selection 

3. Click Change.  

4. Make the required changes to the order.   

5. Execute the Order > Validate and Submit menu command or 
click the Submit icon. 

 

Visual Notification for RPON 

An alert will be generated if the user modifies (i.e., supplements) an LSR that 
has been successfully submitted if the version of that LSR had the  RPON 
field populated.  
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1. VFO user logs in and initiates a sup against a LSR that was 
previously submitted to the TP 

2. If the LSR.RPON field is populated in the version that is being 
supp’ed, a new pop-up window is displayed with the following 
alert: “The PON you reverted to/are supplementing has an 
RPON 

 

Figure 66: RPON Visual Notification – LSR 

3. User clicks on the OK button,  
4. SUP pop-up window is displayed, user proceeds with 

populating the Version field and clicks on the Change button 
and proceeds with supplementing the order 

Visual Indicator for RPON 

If a local order has an associated RPON field populated, then a new icon ‘R’ 
will be displayed in the Order list to distinguish PONs with the RPON field 
populated. In the even there is more than one version for a PON, the RPON 
icon will be displayed if the latest version has the RPON field populated. 
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Figure 67 - Visual Indicator for RPON 

Revert to Last Saved 

You can create responses and choose to save them.  Then you can 
use the History screen to open the last saved version of the response 
or revert to an earlier saved version. Click the PON next to the 
response you want to view, modify, transmit, etc. Once you click Save, 
Validate, or Submit this response becomes the current response.  

Revert to Last Submitted 

If you modify a Service Request after you successfully submitted it 
(i.e., started a supplement request), you can return to the previously 
submitted version of the Service Request by executing the Order > 
Revert > Revert to Last Submitted command. This command restores 
the previously submitted version of the Request even if you executed 
the Save command to save those changes. 

Void Service Requests 

VFO allows you to void a Service Request for any reason, as long as 
the Service Request has not been sent to the Trading Partner.  This 
also includes orders that have been submitted but received a System 
Error. 

When the initial orders have been rejected by the trading partner, the 
order can be voided in VFO.  However, if the order has been 
supplemented it cannot be voided.  

To void a Service Request: 

1. Open the Service Request. 

2. Hover the Order tab. 

3. Click the Void menu command. 
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Inactivate and Activate Orders 

All active orders created in the application are stored in the Order List 
by default.  Orders are considered Active unless a user specifies 
otherwise.   

The only orders not displayed with the default filter are "Inactive" 
orders, however you can choose to include those orders in the Order 
list by checking the check box "Include Inactive Orders."  

Inactivating Orders   

Orders became "Inactive" when a user applies this label to the order. 
To indicate an order is inactive the user: 

1. Opens the Order by clicking the PON in the Order list.  

2. Hovers over the Order tab. 

3. Selects the menu options Edit > Inactivate Order.  

4. The status of the order will be appended with the word 
"/Inactive." 

The functions available on an inactive order are the same for an active 
order sharing that same status.  

Activating Orders 

To make an Inactive order Active: 

1. Click the PON in the Order list to open the Order.  

2. Hover over the Order tab. 

3. Select the menu options Edit > Activate Order. 

The "/Inactive" text will be removed from the order status and it will 
appear on the Order list when the default filter criteria is used.   

Printable Version 

The Printable Version command in VFO displays the current Service 
Request in a format that is friendlier to your printer.  

From the Service Request page, execute the Order > View > View 
Printable Version menu command. A new window opens that displays 
the fields of the Service Request without the application controls .  

Use the browser’s print tool to print the window. 
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This section reviews the following: 

• Creating Templates 

• Saving Templates 

• Applying Templates After Order Initiation 

• Searching for Templates 

 

Create a Template 

Templates use common data values to pre-populate orders, thereby 
reducing or eliminating redundant data entry and the attendant errors. 
VFO lets you tailor your own templates for every type of Service 
Request, as well as give you the ability to modify, update, or delete an 
existing template from VFO. 

Use the following procedure to create a template. 

1.    Login to VFO and select the Local module. This opens the 
Order List page. 

2.   Hover your cursor over the Template tab. This reveals the 
Template menu. 

3.   Execute the Template > New menu command. This opens the 
Template Initiation page. 

 

Figure 68: Template initiation page 

  

      Template Name - Enter a user-defined, unique name for the 
template. 
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      Template Description - Enter a user-defined value that 
describes the template. 

      Trading Partner - Select a service provider to display their 
available Service Centers. 

      Service Center - Select a Service Center to generate a list 
of their available versions. 

      Guideline Version - Select a version. 

      Service - Click this dropdown menu to select the Service 
Type for the negotiation of the service request.  

      Activity - Click this dropdown menu to identify the activity 
involved in this service request.  

      Initiate - Click this button to submit the values entered on 
this page and add the new template to the list of available 
templates. 

      Cancel - Click this button to ignore the values entered on 
this page and return to the Order List page. 

4.   Populate the Template Initiation page. 

5.    Click Initiate. This opens the shell of an order, update or 
trouble ticket, depending on the module you are logged into. 

6.   Populate the fields with common data values that, when 
selected, will pre-populate a new form.  

7.    Click the Save icon in the upper-right corner of the page. This 
saves the values to the database. 

Save As Template 

Another way to create a template is to execute the Save As Template 
menu command. This command is available in the Order menu on the 
Order List page and in the Order menu on the Service Request.  

Use the following procedure to save a Service Request as a template:  

1.    If you are on the Order List page: 

a.    Click the radio button of the Service Request you want to 
use as a template. 

b.   Execute the Order > Action > Save As Template menu 
command.  

2.   If you are in the Service Request:  

a.    Execute the Order > Action > Save As Template menu 
command.  

3.   Either of these commands opens the Saved Order as New 
Template window. 
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4.   Enter a unique value in the Template Name field.  

5.    Click Save. 

Apply Template after Order Initiation 

The Apply Template command populates blank fields of a Service 
Request with the respective values of the selected template. Use the 
following procedure to apply a template from within a Service Request 
Order form: 

1.    Initiate a Service Request. 

2.   Execute the Order > Edit > Apply Template menu command. 
This opens the Apply Template window. 

3.   Select the desired template from the dropdown menu. 

4.   Click OK. 

Search for a Template 

Use the following procedure to search for a template. 

1.    Login to VFO and select the module. This opens the Order List 
page. 

2.   Hover your cursor over the Template tab. This reveals the 
Template menu. 

3.   Execute the Template > Search menu command. This opens the 
Template List page, which lists all available templates.  

 

Figure 69: Template list 

 

      Template Name - Enter the name of the template, and then 
click Go or click the template name link to search on that value.  
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      Trading Partner - Enter the value that identifies the service 
provider in this service request, then click Go to search on that 
value. 

      ServiceType - Enter the value that identifies the type of 
service and then click Go to search on that value. 

      Activity - Enter the value that identifies the activity involved in 
this service request, then click Go to search on that value. 

      Delete - Click a radio button(s) that corresponds to the 
template to remove, and then click the red X in the upper right 
corner of the page to remove a template from the Template List 
and the database. 

      Go - Click this button to submit the search criteria entered on 
the page to the Template database. 

      Clear - Click this button to remove the search criteria from the 
fields on the Template List page. 

NOTE: Executing the Clear command does not clear radio button 
selections. 
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This section reviews the following: 

• Using the Trouble Administration Work List 

• Viewing the Transaction History 

• Creating a Trouble Report 

• Creating Trouble Templates 

• Modifying Trouble Reports 

• Providing Additional Trouble Information 

• Canceling a Trouble Report 

• Late Bonding 

• Escalating Requests 

• Retrieving Trouble Info Requests 

• Retrieving Trouble Report Status 

• Verifying Repair Completion Requests 

• Viewing Attribute Value Change Notifications 

• Creating Mechanized Loop Tests 

• Trouble Administration Contact Information 

 

Login Procedure 

Use the following procedure to login to VFO. 

1.    Browse to the location of VFO by entering the following address 
in the Address field: 
                  https://vfo.frontier.com/  

https://vfo.frontier.com/


  

© 2022 Frontier Communications Parent, Inc. All rights reserved. 93 

 

Figure 70:  Login page 

2.   Enter a valid name in the User Name field.  

3.   Enter a valid password in the Password field.  

4.   Choose TA from the Module Drop Down list on the VFO sign in 
page. 

5.    Click the Login button. 

NOTE: You must use the User Name and Password provided by your 
system administrator. 

Change Password 

Use the following procedure to change the VFO Login password.  

1.    Browse to the location of VFO. 

2.   Enter a valid name in the User Name field.  

3.   Enter a valid password in the Password field.  

4.   Use the User Name and Password provided by company’s 
System Administrator. 

5.    Click the dropdown arrow in the Module field. 

6.   Select the desired Module. 

7.    Check the Change Password checkbox. 

8.   Click the Login button. 
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Figure 71: Change password page 

9.   Enter the old password into the Old Password field.  

10. Enter the new password into the New Password field.  

11. Reenter the new password into the Confirm New Password 
field. The 'Password Rules' link mentions the criteria for 
choosing a new password.  

12. Click the Update Password button. 

13. Log in using the new password. 

Password Rules 

The password rules are intended to maintain the system security by 
prompting users to provide strong passwords and use them 
appropriately. 

http://en.wikipedia.org/wiki/Password
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Figure 72: Password Rules 

 

The Work List displays all of the tickets entered into the system. Each 
line represents a particular ticket and shows the Ticket ID, Time and 
Date Created, date/time last update received, Network ID, State and 
Status of the ticket, the Agent Trouble Report ID, the Customer 
Trouble Ticket number, the last tech assigned to the ticket , the trouble 
type and the Chronic column. 

Newly added tickets are color coded so you can monitor the ticket’s 
progress.  The ticket starts shaded green, then goes to yellow, and 
then to red.  The duration of the colors can be modified by the System 
Administrator.  The default is green for ten minutes, yellow for 30 
minutes, and red for one hour, after which it has a white background.  
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Figure 73: Trouble administration work list 

      Ticket - Hover over this tab to allow Users to create Trouble 
Tickets and reassign Trouble Tickets to other Users.  

      MLT - Hover over this tab to access the Mechanized Loop Test 
function.  This function is detailed in the last section of this 
chapter. 

      Search - Hover over this tab to access the search 
functionality.  This function will allow the User to perform a 
Trouble Report Search, a TA message search, an MLT search 
and an address search by ECCKT.  This tab also allows Users 
to return to the most recent search performed during their 
session. 

      Template - Hover over this tab to draft ticket information that 
can be applied to actual tickets. 

      Administration - This tab only appears for those Users with 
access to Administrative functions.  These Users can create 
new users, reset passwords, delete users, etc.  

NOTE: The Last Assignment field is only populated after a Trouble Ticket 
has been reassigned. 

Below are some States you may see in the Work List:  

      Queued 

      Open Active – status codes 1-12, 18, 19, 21-23, 34 or 35 
might apply 

      Deferred – status codes 13 - 17 might apply 

      Cleared – status codes 20, 24, 25 or 26 might apply 

      Closed – status codes 27 – 33 might apply 

      Disabled 
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Below are some Statuses you may see in the Work List:  

1.            Screening 

2.           Testing 

3.           Dispatched In 

4.           Dispatched Out 

5.            Pre Assigned Out 

6.           Bulk Dispatched Out 

7.            Start Repair 

8.           Pending Test 

9.           Pending Dispatch 

10.        Request Repair 

11.         Refer Maintenance Center 

12.         Refer Vendor 

13.         No Access Other 

14.         Start No Access 

15.         Stop No Access 

16.         Start Delayed Maintenance 

17.         Stop Delayed Maintenance 

18.        Trouble Escalated 

19.         Craft Dispatched 

20.        Temporary OK 

21.         Cable Failure 

22.        Originating Equipment Failure 

23.        Back Order 

24.        Cleared/Customer not advised 

25.        Cleared/Customer advised 

26.        Cleared Awaiting Customer Verification 

27.        Closed Out 

28.        Closed Out by Customer Request 

29.        Closed Out Customer Verified 

30.        Closed Out Customer Denied 

31.         Cancelled Pending Work in Progress 

32.        Cancelled Pending Test Completion 

33.        Cancelled Pending Dispatch Completion 
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NOTE: Frontier Only supports these Status codes - 1, 2, 3, 4, 9, 14, 15, 16, 
17, 21, 26, 28, 29, and 30 

There may be an icon in front of some of the tickets to indicate 
different work states. Following are what these icons represent:    

Double Vertical Bar 
Ticket is in "New" state. A ticket will be in the "New" State when it has 
been sent but has not received a "Create Response" from the Trading 
Partner or received a "Reject Response" or “Fallback Error”.   The 
ticket can be corrected and sent again by clicking on the radio button 
next to that ticket and choosing the "Create As" option from the 
"Ticket" drop down list. 

Reject Errors 

Below are some examples of Reject Responses that might cause the 
ticket to remain in “New” status.  These errors are displayed in the 
Error Column in the Ticket History. 

      Resource Limitation - Trading Partner OSS back end system is 
down and information cannot be sent/received. 

      Access Denied – The Network ID and Account Name combination 
are incorrect. 

      No such Object/Instance – If a transaction is sent to the Trading 
Partner on a ticket that is closed in their back-end system this error 
may be returned. 

      Must be Present Attribute Missing – A required field is not 
populated on the Create Request. 

      Invalid Attribute Value – A field is populated with incorrect data – 
i.e. hyphens in a telephone number field. 

      Missing Attribute Value – A required field is not populated on a 
transaction sent after the ticket has been opened (after Create is 
sent and a good response received). 

      Cannot Verify or Deny at this time– If a transaction is sent on a 
ticket in a state/status of “Cleared Waiting customer verification” or 
a Verify Completion transaction is sent to the Trading Partner but 
no AVC request to close was previously received from the Trading 
Partner for that ticket, this error message may be returned.  

      Trouble Report Change Denied – When a transaction is sent on 
an open ticket but the ticket is not in the appropriate state/status 
for that type of transaction, i.e. an escalation request is sent on a 
ticket in cleared state. 

      Trouble Report Already Exists – A Create is sent to the Trading 
Partner but they already have an open ticket on that circuit (may 
have been opened via a phone call). 

Fallback Errors 
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Below are industry standard fallback error codes  that might cause the 
ticket to stay in “New” status. (The values in bold type below are the 
ones most commonly returned.) 

      Circuit Mismatch 

      Create in Progress 

      Circuit Ownership 

      Invalid State Code 

      Invalid Segment 

      Leading Zeros 

      New Service Pending 

      Circuit Disconnected 

      Invalid Company Assigning Code 

      Invalid Circuit Format 

Clock 
Ticket has been “Deferred”. 

 

Flame  
Ticket needs attention. The ticket has received a notification from the 
Trading Partner requesting authorization or closure of the ticket.  

 

Green Check Mark 
Ticket has been "Closed". The repair was successfully completed and 
the ticket has been closed by the Trading Partner. 

 

Red Bell  
Ticket has errors. The GUI Validation has found a violation in one or 
more fields and requires correction before the ticket can be 
successfully sent to the Trading Partner. 

 

Filtering the Worklist 

The Worklist can be filtered to show only the trouble reports you are 
interested in viewing.  You can also use the filter to setup an auto 
refresh interval.  This allows you to monitor trouble reports when you 
are not actively using the application. 

1. To access the filter, click the funnel icon in the upper right 
corner of the Worklist.  
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Figure 74: Work List 

2. Select the criteria to apply to the Work List trouble reports.  

 

Figure 75: Work List Filter 

3. Click Apply. 

Note:  Display Groups are groups of users created by VFO 
Administrators.  When a Display Group is selected the Work List 
will show only trouble reports created by those users that meet 
the other criteria selected. 
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History 

To view additional information on the tickets listed in the Work List, 
you can access the History section.  The History section can be 
accessed by clicking the icon that looks like an open book.  

 

Figure 76: Trouble report message history 

From the screen above, you can click the ID to access the Trouble 
Report Detail screen.  The Message ID is used to view the specific 
transaction details. 

Trouble Report Detail 

 

Figure 77: Trouble report detail 

Clicking the History Message ID displays the transaction response 
details. 
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Figure 78: Verify repair completion request detail 

 

 

Figure 79: AVC notification detail 

Create a Trouble Report 

Use the following procedure to create a Trouble Report:  

1.    Hover your cursor on the Ticket Tab and a drop-down list will be 
displayed. 

2.   Execute the Ticket>Create Trouble Report menu command. This 
opens the first page of the Create Trouble Report Request.  
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Figure 80: Create Trouble Report Request 

 

3.   Populate required fields on the Create Trouble Report Request 
page. 

      TRFD is chosen depending on whether the service is POTS, 
a Circuit with a premise address, or a circuit without a 
premise address, such as a Message Trunk. 

      Account Name is the identifier for your company that has 
been specified by the Trading Partner chosen in the Network 
ID entry. 

      Network ID is the ID for the Trading Partner to whom the 
ticket will be sent. 

      Service ID is the 10-digit telephone number or Circuit ID for 
the ticket that you are entering. 

4.   If you have a template, you can select the template applicable to 
the ticket you are entering, and then populate the remaining 
fields. 

5.    Click Next. This opens the second page of the Create Trouble 
Report Request.  
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Figure 81: Create trouble report request 

 

6.   Populate the relevant fields under the Ticket Info and Loc & 
Access tabs. 

7. If the Repeat Report field is populated with ‘Chronic,’ then the 
Chronic column in the work list will be populated with ‘Y’ else it 
will be populated with ‘N’. 

8.    The A Location Address under the Loc & Address Tab will be 
auto-populated when the customer has an Access/Local order in 
the VFO system and the Service ID is found on one of those 
orders that has been submitted and accepted by the Trading 
Partner. 

9.   If the TRFD chosen on the initial Create Trouble Ticket Request 
page is a TRFD1 or TRFD2, you must populate the relevant 
fields under the Authorization and Escalation tabs. 

10.   Click Submit.  VFO validates the information contained on the 
Report and generates a list of violations based on industry 
standard rules.  There are no Trading Partner specific rules to 
use to perform validation. 



  

© 2022 Frontier Communications Parent, Inc. All rights reserved. 105 

 

Figure 82: Create trouble report request 

10. If the Report Request contains violations, click the violation(s) 
in the Validation Error(s) list to link to the field that needs 
correction. Once you have made all necessary corrections, click 
Submit again to send Report Request to the Trading Partner.  

11. When the request has been accepted by the Trading Partner, a 
Create Response will be returned, and the Ticket will be 
updated with the Agent Ticket number and Trading Partner 
contact information. The Create Request and Create Response 
will be retained under the History tab. To see if a response has 
been received while you are still in the ticket, click the Refresh 
icon. 

NOTE: The users can also opt to pre-populate the address information 
from the Search by ECCKT results page, into the Trouble Report 
Initiation GUI.  This will result in the auto-population of the 
TRFD, Account Name, Network ID, Service ID and Location 
Address fields in the new Trouble Report. 

 

Trouble Templates 

Templates help save time by pre-populating data that is entered 
frequently on Trouble Tickets. 

Use the following procedure to create Trouble Report templates.  

1.    Hover your mouse over the Template tab. 
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2.   Click the desired template (e.g. New Escalate). This will open 
the template page.  Below is a template for creating a new 
Trouble Report Request. 

 

Figure 83: Create trouble report request template 

 

3.   Populate the template with the frequently used data for that 
ticket transaction. 

4.   Click the Save icon at the top of the page. 

 

Modify Trouble Report 

Use the following procedure to modify a Trouble Report Request.  

NOTE: The Report Request must be in Open status in order to be 
modified. 

1.    Click the radio button that corresponds to the Trouble Report 
Request you want to modify. 

2.   Execute the Ticket > Modify Attributes menu command. This 
opens the Modify Attributes Request page. 
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Figure 84: Modify attribute request 

 

3.   Make the desired changes.  

4.   Click Submit. 

When the ticket is received and accepted by the Trading Partner, a 
Modify Response will be returned. The Modify Request and 
Response will be retained under the History Tab. 

 

Additional Trouble Information 

Use the following procedure to submit additional information on a 
Trouble Report to a Trading Partner. 

1.    The Report Request must be in Open status in order to add 
information. 

2.   From the Work List, click the radio button that corresponds to 
the Trouble Report Request on which you want to add 
information. 

3.   Execute the Ticket > Add Trouble Info menu command. This 
opens the Add Trouble Info Request page. 
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Figure 85:  Add trouble info request 

 

4.   Enter additional information as text. 

5.    Click Submit. 

When the Trading Partner receives the Add Info Request, a Modify 
Response will be returned. Both the Request and Response will be 
retained under the History tab and the information will be updated on 
the appropriate section of the ticket. 

Cancel Trouble Report 

Use the following procedure to cancel a Trouble Report if the ticket 
was created by mistake. 

1.    The Report Request must be in Open status in order to be 
cancelled. 

2.   From the Work List, click the radio button corresponding to the 
Report Request you want to cancel. 

3.   Execute the Ticket > Cancel menu command. This opens the 
Cancel Trouble Report Request window. 

 

Figure 86: Cancel trouble report request 

 



  

© 2022 Frontier Communications Parent, Inc. All rights reserved. 109 

4.   Populate the relevant fields. 

5.    Click Submit. 

When the Trading Partner receives the Cancel Request, a Cancel 
Response will be returned, and the status of the Ticket will be 
changed to show that it has been canceled. The Cancel Request 
and the Response will be retained under the History tab.  

 

 

 

 

 

 

 

 

 

Late Bonding 

If a ticket was called into the Trading Partner and you wish to create a 
ticket so that you can receive updates and send modifications 
electronically, you can execute the Late Bonding process.  

Use the following procedure to execute the Late Bonding process.  

1.    Hover over the Ticket tab and execute the Ticket>Create 
Trouble Ticket menu command. This opens the Create Trouble 
Ticket initial entry page.  

2.   Follow the steps under the Create Trouble Ticket section to 
enter a ticket for the Telephone Number or Circuit that had a 
Trouble Report called into the Trading Partner Repair Center.  

3.   When the Create Request is received by the Trading Partner 
and it is found that there is already a ticket in an open status the 
Trading Partner returns a "Ticket Already Exists" reject 
response.  

4.   When the Trading Partner received the request and already has 
the ticket, a Response will be returned containing all of the 
information on the Trading Partner Trouble Ticket. The ticket will 
be updated with all of the information in the Trading Partner’s 
response, the State and Status will be updated to reflect what 
was returned on the Retrieve Trouble Info response. 

The Ticket is now electronically bonded, will receive status updates 
and notification from the Trading Partner, and can be modified by the 
User. 

NOTE:  

If the Trouble Report Status is: 

• Craft Dispatched,  

• Tech en Route, or  

• Tech On Site,  

a cancel request will result in an Invalid Data Received Error (0). These Trouble Report Statuses 

indicate a tech is either loaded to the ticket or working on it. Customer must send an additional note 

electronically or call in to the center to manually cancel the dispatch.  

Wholesale customers dial 877-500-5514. 
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Escalation Request 

Use the following procedure to escalate a Trouble Report Request.  

NOTE: The Report Request must be in Open status in order to be 
escalated. 

1.    From the Work List, click the radio button that corresponds to 
the Trouble Report Request you wish to escalate.  

2.   Execute the Ticket > Escalate menu command. This opens the 
Escalation Request. 

  

Figure 87:  Escalation request 

 

3.   Populate the relevant fields. Fields identified above are 
required. 

4.   Click Submit. 

When the Escalation Request has been received by the Trading 
Partner, a Modify response will be returned. Both the request and 
response will be retained under the History tab and the Escalation 
information will be updated under the Escalation tab.  

 

Retrieve Trouble Info Request 

Use the following procedure to get information on a Trouble Report 
Request. 
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NOTE: The Report Request must be in Open status in order to get 
information. 

1.    From the Work List, click the radio button that corresponds to 
the Trouble Report Request on which you want information.  

2.   Execute the Ticket > Retrieve Trouble Info menu command. This 
opens the Retrieve Trouble Info Request page. 

 

Figure 88: Retrieve trouble info request 

3.   Click Submit. 

When the Request has been received by the Trading Partner, a 
Retrieve Trouble Info Response will be returned by the Trading 
Partner and the information displayed on the Trouble Ticket will be 
updated to match the data returned if it is different than what was 
previously displayed.  

The Retrieve Trouble Info Request and the Response will be retained 
under the History tab. 
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Verify Repair Completion Request 

Use the following procedure to create a Verify Repair Completion 
Request. 

1.    From the Work List, click the radio button that corresponds to 
the Trouble Report Request that requires the Verify Repair 
Completion Request. 

2.   Execute the Ticket>Verify Repair Completion menu command. 
This opens the Verify Repair Completion Request page. 

 

Figure 89: Verify repair completion request 

3.   Populate the relevant fields to either approve the ticket closure 
(Verified) or deny the closure because there is still an issue.  

4.   Click Submit. 

If the ticket closure is approved (Verified), the AVC returned from the 
Trading Partner will change the ticket status to Closed. 

If the ticket closure is denied, the AVC returned from the Trading 
Partner will change the ticket status to Dispatch, Pending Test, 
Screening or whatever status is returned on the AVC, and the ticket 
will remain open. 
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Requesting Vendor Meets 

Request when Denying Ticket 

• Use the Verify Repair function. 

• Select Deny. 

• Enter “Vendor Meet Requested” in the Close Out Narrative field.  

• Call to schedule Vendor Meet – 1-877-500-5514. 

If ticket is closed send new ticket  

• Create a new ticket. 

• Select Trouble Type value “Manualintervention required”  

• In the Additional Information field enter “Vendor Meet Request,” the 
previous ticket number and dispatch date.  

• Submit the ticket. 

NOTE:  To schedule a Vendor Meet, in addition to opening an electronic 
trouble report, Carriers must contact the CCSC at 877-500-5514. 
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Attribute Value Change Notifications 

The Trading Partner will send an Attribute Value Notification (AVC) to 
update the ticket information or request an action on the part of the 
User. 

Status Notifications 

The Trading Partner will send an AVC to update the ticket Status 
whenever a change is made to the ticket, and on a regular basis 
corresponding to the time interval entered in the Status Window fields 
when the Create Trouble Ticket was submitted. 

Authorization Request Notifications 

The Trading Partner may send an AVC to request authorization for 
Dispatch, After Hours Repair or any of the other valid requests listed 
under the Authorization tab.  

The Flame icon will appear next to the ticket in the Work List when an 
AVC for authorization is received. 

If an Authorization Request is received, the User will send a Modify 
Request and populate the relevant fields under the Authorization tab 
to either approve (Provide) the Authorization or Deny it.  

Request to Close Notifications 

If the Trading Partner sends an AVC request to close the Trouble 
Ticket the status will be changed - "Cleared waiting Customer 
Verification" is a status that might be received on the AVC and 
updated in the Status field on the ticket.  In the Work List, that ticket 
will also have a Flame icon to alert the User that an action is required.  

After checking to be sure that the repair issue has been fixed, the 
User will submit a Verify Repair Completion Request.  

Mechanized Loop Test (MLT) 

Before entering a Ticket for a POTS service, you may wish to request 
that a Mechanized Loop Test be done to ensure that the trouble 
resides at the Trading Partner.  

Use the following procedure to enter the MLT Request.  

1.    Hover your cursor over the MLT Tab and choose Create MLT 
Request from the drop-down list. This will open the MLT 
Request page. 
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Figure 90: Create MLT request 

2.   Populate the MLT fields with the relevant information, (i.e. 
Account Name, Network ID Service ID and Test Request Type). 

3. Click Submit.  

4. Click Refresh and when the response is received, the Response 
ID will be displayed on the screen. 

The response from the ILEC will provide the test results for that POTS 
service. 

You can view all MLT test responses by using the MLT search 
selection under the Search Tab. If the MLT test is done and a ticket is 
subsequently entered, or it is done on a ticket that already exists, the 
MLT results will be displayed under a "Last MLT" tab which will be 
displayed after the Assignments tab on the Trouble Report Detail 
Screen. 

Click the Last MLT tab to display the Test Results.  

Trading Partners may provide any combination of the following 
information depending on the type of request:  

POTS Service Test Results (MLT) 

FULL - Summary description of the test results 

Optionally, DC Signature results: Tip to ground resistance  

          Tip to ground voltage 

          Ring to ground resistance 

          Ring to ground voltage 

          Tip to ring resistance 

Optionally, AC Signature results: Ringers - 0 or 1 

          Tip to ground resistance 

          Ring to ground resistance 

          Tip to ring resistance 

Optionally, balance results: Capacitive (percent)  

          Longitudinal (decibels) 
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Optionally, loop results, either: Total loop 

          Open distance from the CO 

Optionally, central office results: Line circuit status  

          Dial tone status 

QUICK 

Optionally, DC Signature results: Tip to ground resistance  

          Tip to ground voltage 

          Ring to ground resistance 

          Ring to ground voltage 

          Tip to ring resistance 

Optionally, AC Signature results: Ringers - 0 or 1 

          Tip to ground resistance 

          Ring to ground resistance 

          Tip to ring resistance 

Optionally, balance results: Capacitive (percent) 

          Longitudinal (decibels) 

Optionally, loop results, either: Total loop 

          Open distance from the CO 

CENTRAL OFFICE - Summary description of the test results 

Optionally, DC Signature results: Tip to ground resistance 

          Tip to ground voltage 

          Ring to ground resistance 

          Ring to ground voltage 

          Tip to ring resistance 

Optionally, AC Signature results: Ringers - 0 or 1 

          Tip to ground resistance 

          Ring to ground resistance 

          Tip to ring resistance 

Optionally, central office results: Line circuit status  

          Dial tone status 

LOOP - Summary description of the test results 

Optionally, DC Signature results:  

          Tip to ground resistance 

          Tip to ground voltage 
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          Ring to ground resistance 

          Ring to ground voltage 

          Tip to ring resistance 

Optionally, AC Signature results: Ringers - 0 or 1 

          Tip to ground resistance 

          Ring to ground resistance 

          Tip to ring resistance 

Optionally, balance results: Capacitive (percent) 

          Longitudinal (decibels) 

Optionally, loop results, either: Total loop 

          Open distance from the CO 
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The Administration section allows users with Administration 
rights to search, create, and modify Users. 

To access Security function, execute the Administration > 
Security menu command. This opens the Security Home 
window. 

 

Figure 91: Security home page 

 

In this section we review the following: 

• Creating User Profiles 

• Searching for Users 

• Modifying Users 

• Creating Display Groups 

After navigating to the Administration tab and selecting 
Security tab, use the following procedure to create a user.  

1. Click the User Profile link. This opens the User Profile 
Search List window. 
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Figure 92: User profile search list 

 

2. Click New. This opens the User Profile Details page. 

 

Figure 93: User profile details 
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WARNING: User Name, Password, User Type, and Primary User Group 
are required fields. 

3. Enter a unique User Name and Password.  Passwords 
are case sensitive and can be any combination of 
characters up to a maximum of 16 characters. 

4. Reenter the password into the Confirm Password field.  

5. Optionally, enter a Full Name and Designation for the 
user.  

6. Select a User Type from the dropdown menu. (The ESP 
Name is pre-populated based on your user profile.   You 
may even be able to associate multiple ESPs to the 
user, depending on your user profile.) 

NOTE: The value(s) available in the User Type drop-down 
menu is determined by your User Profile 
configuration. You cannot assign a User Type other 
than the one you have been assigned. 

7. Optionally, enter a Phone number and Auto-Pop Email 
Address.  The Email Address will be populated by the 
user when they log in the first time. 

8. ESP Name, the available values will show in the 
Available box.  Move the ESP Name to either the Read 
Write or Read Only Permission box depending on the 
access for that user. 

NOTE: When more than one is available, you can move the values 
to selected box for either Read Write or Read Only 
Permission. 

9. Select the Group to which the new user will belong, and 
place it in the Available list. 

10. Click the right-pointing arrow that corresponds to 
the Primary Group field. 

11. Optionally, select another Group and then click 
the right-pointing arrow that corresponds to the 
Secondary Group field to add the privileges associated 
with that group. This gives the user the privileges of 
both groups. 

12. Click Save. This returns you to the User Profile 
Search window. 

 

Use the following procedure to search for users. 
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1. Execute the Administration > Security menu command. 
Click on the User Profile link. 

2. Input the User Name of the user you are looking for. 
Alternately, you can input the Group Name said user 
belongs to. 

 

Figure 94: User profile search list 

NOTE: Remember you can use the % wildcard. (E.g. a% would 
return all the users with 'a' at the beginning of their user 
name.) 

 

Use the following procedure to make changes to a user’s 
attributes. 

1. On the User Profile Search List window, click the link of 
the User Name you want to modify. This opens the 
User Profile Details window for the selected user.  

2. Make the desired changes. 
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Figure 95: Modify user profile details 

 

3. Click Save. A Status message appears stating that the 
profile was successfully updated. 

Displays Groups are a set of users grouped for the purpose of 
filtering the Order List (Work List in the case of TA).  This 
function is available in the Local, Access and TA Modules.  

To create a Display Group: 

1. Hover the Administration tab. 

2. Click the Security menu option. 

3. Select Display Groups. 

4. Click New. 

 

Figure 96: Display group search list 
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5. Enter a Display Group Name, Description, and select 
users. 

 

Figure 97: Display Group Details Screen 

6. Click Save.  

After you have several Display Groups created, you may need 
to access one to add or remove users from the group.  

You can search by the Display Group name or use % as a 
wild card character. 

1. Hover over the Administration tab. 

2. Click the Security menu option. 

3. Click Display Group. 

4. Enter Display Group name or part of the name and use 
% as the wild card character. 

5. Click the Go button. 

 

Figure 98: Display group search list 
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6. Click the Display Group Name to open the group to 
modify the users associated. 

To move the users around from one group to another you can 
use Bulk Reassignment.  

1. Hover the Administration tab. 

2. Click the Security menu option. 

3. Click Display Groups. 

4. Click Bulk Reassignment. 

 

Figure 99: Display group search list 

5. Select a group from the "From Group" and To Group 
options.  

 

Figure 100: Bulk reassign display group users 

6. Click Save.  
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Date Page Revision 

01/03/2022 All Revised User Guide 

06/15/2022 13 Revised supported browsers 

06/30/2022 38 Remove invalid screenshots for step 2 

07/27/2022 42, 43, 44 Add Access Order Service Types Table 

08/03/2022 42, 43, 44 Update Access Order Service Types Table 
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